
    DPLOT Help Contents

DPLOT is a general purpose X-Y plotting program that allows you to view, manipulate, and produce hard 
copies of data in a variety of formats.

To learn how to use Help, press F1
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    Menu Commands

To get information about individual menu commands

1.  On the toolbar, click the Help button.
    Help button
The mouse pointer changes to a question mark:
    Help pointer

2. Click the menu you want, and then click the command name for which you want 
information. DPLOT displays Help for that menu command.

____________________________
See also:

File Menu Commands 
Edit Menu Commands 
Text Menu Commands 
Options Menu Commands 
Generate Menu Commands 
Info Menu Commands 
View Menu Commands 
Window Menu Commands 



    Parts of the DPLOT Screen

To get information about parts of the DPLOT screen:
1. On the toolbar, click the Help button.

    Help button
The mouse pointer changes to a question mark.
    Help pointer

2. Click the part of the screen you want more information about. For general information about the 
toolbar, click anywhere on the toolbar except on a button. For information about a toolbar button, click
the button. DPLOT displays the Help window.

____________________________
See also:

Status bar description 
Toolbar description 



 Programmer's Reference

Using WinExec to plot an existing file
Executing DPLOT commands from another application
Using DDEML to send binary data directly to DPLOT
Getting a bitmap of the currently active DPLOT document



    View Menu
All

Display the full plot extents, dependent on whether Manual Scaling is in effect.

Zoom In
Allows you to specify the extents of the plot using the mouse. This command is disabled for polar 
coordinates.
Shortcut: Click        on the toolbar.

Zoom Out
Displays the previous view (before the last Zoom In command) of a plot.
Shortcut: Click        on the toolbar.

Move to Front
Changes the index of the selected curve so that it is the last curve to be plotted.

Send to Back
Changes the index of the selected curve so that it is the first curve to be plotted.

Status Bar
Toggles the display of the status bar at the bottom edge of the window.

Toolbar
Toggles the display of the toolbar. See Toolbar Description 

Large Buttons
Toggles the size of the toolbar buttons between the default 24x22 pixels and 32x30 pixels.

Redraw
Redraws the currently active window after canceling a previous redraw with <Escape>.
Shortcut: Click        on the toolbar.

Acceleration (or Velocity/Displacement)
Toggles the view in Data Processing mode for data types that produce multiple plots. This menu 
command is hidden if Data Processing mode is not in effect.

____________________________
See also:

Data Processing Mode 
Status Bar Description 



    Window Menu
Cascade

Displays the open document windows in an overlapped arrangement, with the active document on 
top.

Tile
Arranges the open document windows as non-overlapped windows.

Arrange Icons
Arranges any minimized document window icons in the lower left portion of the DPLOT application 
window.



    Keyboard Shortcuts

The following list summarizes the general pattern in keyboard shortcuts:

· ENTER is used to confirm or carry out an action.

· ESC is used to cancel an action.

· Function keys (F1, F2, and so on) are used as shortcuts for common commands and actions.

· INSERT, DELETE, and BACKSPACE are used primarily with editing.

· TAB, the arrow keys, HOME, END, PAGE UP, and PAGE DOWN are used primarily for moving, 
selecting, and scrolling.

· ALT is generally used for actions related to application windows, such as choosing commands 
and dialog box options.

· SHIFT usually means one of the following:

· Extend the selection.

· Perform the opposite action.

· Go in the opposite direction.

· CTRL is used in several keyboard shortcuts. In addition, it can mean one of the following:

· Perform the same action on a different scale.

· Perform a slightly different action on the same object.

Keyboard Shortcut Reference
DPLOT has a set of keyboard shortcuts that you can use to carry out commands and select dialog box 
options directly from the keyboard - by using these shortcut keys, you bypass the menus. With other 
shortcut keys, you can move, select, and edit large documents more efficiently.

Keys that must be pressed sequentially are shown separated by a comma; keys that must be pressed at 
the same time are shown separated by a plus sign.

Help keys
To Press
Switch to Help window F1
Switch to context-sensitive Help SHIFT+F1

Editing
To Press
Carry out an action ENTER
Cancel an action ESC
Clear the selection DELETE
Copy the active document to the Clipboard CTRL+C
Paste data from the Clipboard CTRL+V

Working with files



To Press
Create a new document CTRL+N
Save the active document with the Save command on the File 
menu

CTRL+S

Open an existing file CTRL+O
Print the active document CTRL+P
Close the active document CTRL+F4
Quit DPLOT ALT+F4

Working with windows
To Press
Select the menu bar ALT or F10
Select the DPLOT Control menu ALT+SPACEBAR
Select the document Control menu ALT+HYPHEN
Close the document window CTRL+F4
Switch to the next open document window CTRL+F6
Switch to the previous open document window CTRL+SHIFT+F6
Arrange all open documents as non-overlapped windows SHIFT+F4
Arrange all open documents as overlapped windows with the 
active document on top. 

SHIFT+F5

Redraw a document after previously interrupting a painting 
operation with ESC

F9



Results Box

You can copy some or all of the text presented by this dialog box to the Clipboard with the Copy button. 
The selected text may then be pasted into another Windows application that supports Clipboard 
operations.

Selecting text
By default, all of the text contained in the text box will be copied.. To select a portion of the text, do one of 
the following:

Press TAB or SHIFT+TAB until the cursor appears in the text box. Using the arrow keys, position 
the cursor at one end of the text you want to select. Hold down the SHIFT key and use the arrow keys to 
select text. Press ALT+C to copy the selected text to the clipboard.

Drag across the text you want to select, then click the Copy button.



    Technical Support

Bug reports, Comments, etc.
Before reporting any suspected bugs, it is important that you be able to reproduce the circumstances that 
led to an error ...what other programs are running, how large is the data set, what type of scaling is in 
effect, etc. Note: See the description of known problems and possible solutions in the Known Problems 
topic before reporting errors.

Please include DPLOT's full version number (select the About DPLOT command on the Help menu) in 
any correspondence.

Attempt to recreate the error by performing the same functions that led to it previously. A full description of
the circumstances leading to the error should be addressed to:

USAE Waterways Experiment Station
ATTN: Hyde /SS-R
3909 Halls Ferry Road
Vicksburg, MS 39180

or call (601) 634-3668 from 7:00AM to 5:00PM Central time, or send e-mail to 
hyded@ex1.wes.army.mil.

Comments or suggestions are welcome.

Updates to DPLOT
Updates to DPLOT are available through:

FTP: sliris.wes.army.mil (IP Address 134.164.56.189),
UserID=anonymous

World Wide Web: http://sliris.wes.army.mil
DPLOTW.EXE will run on any of Windows 3.1 or later, Windows 95, or Windows NT. 
DPLOT95.EXE requires Windows 95 or Windows NT v4.0 or later.

Download the file DPLOTW.ZIP or DPLOT95.ZIP to an empty temporary directory on your 
hard disk. Expand this file using the file decompression utility PKUNZIP.EXE, version 2.04 
or later. Start Microsoft Windows, select Run from the Program Manager File menu or the 
Start button, and type [d:\path\]setup.exe, where [d:\path\] is the location of the 
temporary directory where DPLOTW.ZIP or DPLOT95.ZIP was copied to. Once the setup 
program has finished all of the files in the temporary directory may be safely deleted.



    Known Problems

Colors on HP 1600c DeskJet Printer with DPLOT for Windows 3.x
According to the Microsoft KnowledgeBase article Q141516, Updated HP PCL5EMS Drivers for NT:

In some cases, when printing to the HP Deskjet 1600c in 24bit
color mode from 16 bit applications, the output received may 
not be in color. This does not occur when printing in 8 bit 
(256 color) mode or the 3 bit (8 color) mode.  This problem 
can be worked around by printing to a lower color mode 
setting or, if possible, printing from a 32 bit version of 
the application.

As stated in the article, upgrading to DPLOT95 should correct any color problems you may be 
experiencing with the HP 1600c on Windows 95 or Windows NT.

Fill Between Curves
The built-in hatch patterns (horizontal lines, vertical lines, etc.) are not drawn correctly on systems 
equipped with ATI Mach32 (and possibly other) graphics adapters. The user-defined pattern, 
however, does work properly.

Generate macro with Windows NT 4.0 Beta
If you are running the Windows 3.1 version of DPLOT (DPLOTW.EXE) on Windows NT 4.0 Beta, 
attempting to use the Generate macro when Microsoft Excel is NOT already running will cause both
DPLOT and the DPLOT Macro Editor to crash. To circumvent this problem, start Microsoft Excel 
before running any macros containing the Generate command, or obtain a copy of DPLOT95.EXE, 
which does not exhibit this problem.

Importing metafiles in Microsoft PowerPoint
If you insert a Windows metafile (.WMF) graphic created by DPLOT, (or paste a metafile picture 
created by DPLOT) into a PowerPoint slide, you will get only an empty frame if any clipping has 
been performed.

If you double-click this empty text frame, or use the Ungroup command, the image converts to 
PowerPoint drawing objects. However, the conversion to PowerPoint drawing objects removes 
clipping information from the picture, so that objects which should have been clipped (not drawn) 
will be visible. This is particularly noticeable if you have zoomed in on a plot or used the Manual 
Scale command to plot a subset of the data.

PowerPoint does not use the shared graphics filter (WMFIMP.FLT) for Windows metafiles located in
the Windows MSAPPS\GRPHFLT subdirectory. It has its own internal filter. DPLOT metafile 
pictures display properly in Word for Windows, Excel, and other applications that use the shared 
filter. The import filter used by PowerPoint does not properly handle clipping regions.

If a portion of a curve extends outside the edges of the plot, you can delete points in PowerPoint by 
selecting the curve (double-click on it), then press Ctrl+click while pointing to a data point(s) to 
remove.

Rotated text with HP LaserJet 4/4M
The HP LaserJet 4/4M printer driver, version 31.1.1.8 or earlier, does not place rotated text 
correctly. The LaserJet 4/4M printer driver, version 31.V1.50, places rotated text correctly but in 
some cases drops characters from rotated character strings.

To fix either of these problems:

Use the HP LaserJet 3 driver distributed with Windows. Although this solution will fix the problem, 
output is limited to 300 dpi.



OR

Use the HP LaserJet 4/4M PostScript printer driver. This driver is usually included on 3-1/2" disk 
with the printer.

OR

Obtain an updated driver (L4WIN3.EXE) from Hewlett Packard. Driver updates are available on the 
World Wide Web at http://www.hp.com or from the Hewlett Packard Download Service at (208) 
344-1691. If this does not fix the problem, it may be necessary to select "Raster" Graphics Mode 
and check "Print TrueType as Graphics" in the Print Setup dialog box. Note, however, that these 
print options result in a much larger printer spool file, and printing speed is considerably slower. 

Text in metafiles overlaps the surrounding border
This problem is due to a limitation on the sizes of available fonts. When a metafile is played back in 
a target application (e.g. a word processor or presentation graphics application), the font sizes 
originally chosen are scaled to the size of the picture, as is the rectangle surrounding this text. 
However, while the rectangle can be scaled to any size, the corresponding font size may not be 
available (Windows selects the closest size available). For best results, select the desired size of 
the metafile using the Copy Dimensions command before copying a plot to the Clipboard or saving 
as a metafile.

Problems and/or suspected bugs not referenced in this topic should be reported to the author as 
described in the Technical Support topic.



    Edit Menu

Copy Picture
Copies a metafile and a bitmap image to the Clipboard.

Copy Data Values
Copies the data points of a single curve to the Clipboard.

Copy Dimensions
Allows you to change the size of bitmaps and/or metafile pictures that are copied to the Clipboard by 
the Copy Picture command.

Paste
Creates a new curve using data from the Clipboard.

Paste Link
Creates a new curve using copied data and establishes a link with the source of the data.

Insert Link
Creates a new curve from data in another application, and links the curve to the source of the data.

Add a Constant to X
Adds a constant value to all X coordinates on one or more curves

Add a Constant to Y
Adds a constant value to all Y coordinates on one or more curves.

Decimate Points
Provides three different methods for reducing data.

Edit Data
Edit data values for a new or existing curve.

Equal Intervals
Generates a new curve with a constant spacing on the X axis.

Erase Curve
Wipes out all data associated with one or more curves.
Shortcut:
Click        on the toolbar.

Filter
Eliminates noise or otherwise alters a time history record.

Multiply X
Multiplys all X coordinates on one or more curves by a constant. For example, if the data consists of a
time-history with time values in seconds, "Multiply X" by 1000 to convert the time values to 
milliseconds.

Multiply Y
Multiplys all Y coordinates on one or more curves by a constant.

Remove Trend
Removes any trend from the amplitude by subtracting a straight line through the first and last points 
(i.e. make the first and last amplitudes equal to zero).

Smooth
Smooths a data record using a low-pass filter.

Sort
Sorts the data for a selected curve in ascending abscissa (X) order. Many DPLOT operations are 
optimized for monotonically increasing values of X.



Swap X,Y
Switches the X and Y values for one or more curves. If the new curve has progressively smaller X 
values, then the order is automatically reversed so that X increases.

Truncate X
Eliminates all data outside a user-specified range. If no data remains, the curve and all associated 
data are erased.

Baseline Shift
Performs the same function as Add a constant to Y, but calculates the desired shift and automatically 
regenerates integrated data in "data processing" mode.

List Editions
Displays a list of all baseline shifts done on a record in "data processing" mode.

Undo Shift
Reverses the previous Baseline Shift performed in "data processing" mode.

____________________________
See also

Data Processing Command



    Copy Picture command (Edit menu)

Copies a metafile and a bitmap image to the Clipboard. A metafile preserves all of the information content 
of a plot. The metafile picture can be scaled and rotated without distortion, and individual graphic entities 
(fonts, for example) may be edited. A metafile is device-independent, so the resolution of the image will be
that of the final destination output device. The bitmap image created by DPLOT differs from the normal 
Windows screen capture in that the image size is fixed at 640x480 (rather than matching the current 
window size), and the title bar, menu, and window borders are not included in the image.

Shortcut:
Click     on the toolbar.
CTRL+C

Output size
If the Automatic Size menu command is in effect, DPLOT produces a metafile with default dimensions of
6 inches wide by 4.5 inches high. These dimensions may be changed in the destination application, but 
you then risk not being able to match font sizes with the intended size. For best results, you should select 
the Set Physical Size menu option and enter the desired dimensions for the width and height before 
copying the plot to the Clipboard.

Clipboard format
Many applications that allow you to paste data from the Clipboard will accept a variety of clipboard 
formats. Microsoft Word, for example, will accept either a bitmap or metafile picture. The target 
application determines which format to use when the Paste command is selected. Most applications that 
accept multiple clipboard formats have a Paste Special command in addition to the Paste command. To 
select a format different than the default, use the Paste Special command in the target application.

Link
In addition to a metafile picture and bitmap DPLOT also copies "link" information to the Clipboard. Any 
Windows application that supports a "Paste Link" command can be linked to the DPLOT plot, so that 
changes made to the plot by DPLOT are automatically transferred to the client application. For example, 
in Microsoft Word select the "Paste Special" command, check the "Paste Link" box, and select "OK". Any 
subsequent changes to the plot in DPLOT will cause the picture in Word to be automatically updated. 
Please note that when using the "Paste Link" option it is up to the client application (not DPLOT) to select 
the desired format (metafile or bitmap). Word, for example, will always request an updated metafile 
picture rather than a bitmap, even if "bitmap" is selected in the "Paste Special" dialog.
 

____________________________
See also

Transferring     DPLOT     Plots     to     Other     Applications  
Copy Data Values



 Copy Data Values command (Edit menu)

Copies the data values of a selected curve to the Clipboard as text. The data may then be imported into a
number of Windows applications that support the "Paste" command. To copy the values of multiple curves
from DPLOT to another Windows application, repeat the Copy Data Values ... Paste sequence for each 
curve.

You may also "link" DPLOT data to any application that has a "Paste Link" command. For example, in 
Microsoft Word select the "Paste Special" command from the Edit menu, check the "Paste Link" box, and 
select "OK". Any subsequent changes (in DPLOT, not Word) to the data copied to the Clipboard will be 
automatically reflected in the Word document. 

____________________________
See also

Copy Picture command



 Copy Dimensions command (Edit menu)

Allows you to specify the sizes of bitmaps and/or metafile pictures that are copied to the Clipboard by the 
Copy Picture command. When DPLOT is first installed, the default bitmap dimensions are 640x480 pixels,
and the default metafile picture dimensions are 6.0x4.5 inches.

NOTE: The metafile picture dimensions are only used when the "Automatic Size" option is in effect. If you 
specify a size by using the Set Physical Size menu command, those dimensions are used for all output 
devices, including metafile pictures.

____________________________
See also

Copy Picture command



    Paste command (Edit menu)

Creates a new curve with data from the Clipboard. The source of the data may be a word processor, 
spreadsheet, or any Windows application capable of copying data to the Clipboard, as well as a DOS 
application running in a window.

Shortcut:
Click     on the toolbar.
CTRL+V

Data organization
Data should be organized as X-Y pairs, or X followed by multiple Y values for each X. Each X data value 
must start on a new line. Values may be separated by spaces, commas, or tabs. No character strings are 
allowed.

Formats
Data values must not include any currency labels, percent signs, commas separating thousands, or any 
other special formatting. Many spreadsheet programs will allow you to remove formatting from a selected 
block of numbers prior to copying the data to the Clipboard. In Microsoft Excel, for example, after 
selecting the data to copy, press DELETE, select Formats, press ENTER, then CTRL+C to copy the 
unformatted data to the Clipboard.

Copying data from a DOS application
You may copy data either from a full-screen application or a windowed application. However, when 
running a full-screen application, you can copy only an image of the contents of the entire screen onto the
Clipboard, so you increase the likelihood of copying invalid characters.

To copy selected information onto the Clipboard

1 Click the application's Control-menu box. 
Or press ALT+SPACEBAR to open the Control menu. 

2 From the Control menu, choose Edit. 
3 From the Edit cascading menu, choose Mark. 
4 In your document, select the information you want to copy. 
5 Click the application's Control-menu box. 

Or press ALT+SPACEBAR to open the Control menu. 
6 From the Control menu, choose Edit. 
7 From the Edit cascading menu, choose Copy. 



    Paste Link command (Edit menu)

Creates a new curve with data from the Clipboard and establishes a link with the source of the data. The 
source of the data may be any Windows application that 1) acts as a DDE server and 2) supports the Link
Clipboard format (including DPLOT). When the source data changes, the pasted data reflects those 
changes.

Data organization and Format
Data should be organized and formatted as described under the Help topic for the Paste command.

To create a link between a source document and a dependent plot in DPLOT
Both applications must be Microsoft Windows applications. 

1 Open the source document in the server application.

2 Select the source data you want to copy into the dependent document in DPLOT. See the 
documentation for the server application for more information on selecting data.

3 From the Edit menu, choose Copy.

4 Switch to the dependent document window in DPLOT.

5 Select Paste Link from the Edit menu.

If the Paste Link command is unavailable when you select the Edit menu, the other application does not 
support linking or cannot supply the data in a format that DPLOT can use.



    Insert Link command (Edit menu)

Creates a new curve with data from a DDE server application and establishes a link with the server. When
the source data changes, the DPLOT plot reflects those changes.

To create a link between a source document and a dependent plot in DPLOT
Both applications must be Microsoft Windows applications. 

1 Open the source document in the server application.

2 Switch to the dependent document window in DPLOT.

3 Select Insert Link from the Edit menu.

4 Type the name of the application in the "Application" box (e.g. Excel or WinWord).

5 Type the name of the DDE topic in the "Topic" box. For most DDE servers, the topic is the name 
of the source datafile. If the file has not been saved to disk, the topic name may be the caption of 
the window containing the data (e.g. Sheet1 in Microsoft Excel or Document1 in Microsoft Word)

6 Type the name of the data item you want to link to in the "Item" box. Check the documentation of 
the server application for valid item names. In Microsoft Excel, items should be cell references in 
R1C1 format (e.g. R1C1:R100C2 refers to the first 2 columns of 100 rows). In Microsoft Word 
items must be tagged with a bookmark, and the item is the name of the bookmark.

Data organization and Format
Data should be organized and formatted as described under the Help topic for the Paste command.



metafile
A collection of Windows Graphics Device Interface (GDI) functions that are encoded in a binary form. 
Some applications may refer to metafiles as the "picture" format.



    Edit Data command (Edit menu)

Allows you to edit data for an existing curve or enter data values for a new curve. The maximum number 
of points that may be edited using this command is currently 1024. If the current number of curves is 
equal to the maximum number of curves (set with the Resize Arrays command) and the maximum 
number of points per curve is less than 1024, DPLOT attempts to resize the arrays by incrementing the 
maximum number of curves so that you may enter values for a new curve.

OK
Accepts the input and closes the dialog box. If the curve has only 1 data point the curve is 
eliminated.

Cancel
Restores previous values and closes the dialog box.

Add
Adds a data point to the end of the array.

Insert
Inserts a data point before the point currently highlighted in the list box.

Delete
Deletes the data point currently highlighted in the list box.



    Decimate command (Edit menu)

Provides three different methods for reducing the number of data points in a curve. Since all of the 
decimation processes are irreversible, DPLOT gives you the option of either replacing or preserving the 
curve that is operated on. Select the Replace existing curve checkbox to replace the original curve with 
the decimated data. Leave the box unchecked to preserve the original data.

Average Points
Averages a user-specified number of amplitudes. Peak values may be lost.

Welch Depopulation Scheme
Preserves only those points that prevent the output record from departing from the original data 
by more than a user-specified ratio of the range between minimum and maximum input values. 
Peak value is preserved. Generally has the best performance of the three methods, but may lose 
detail in low-amplitude regions of the data. Developed by Bob Welch, CEWES-SE-R. Click to see 
example.

Skip Points
Preserves every Nth point, where N is user-specified. Peak values may be lost.

____________________________
See also

Resize Arrays





    Filter data (Edit menu)

The Filter command provides several methods for digitally filtering time histories. All but one of the filters 
employed by DPLOT use the following linear filter:

where
x = input amplitudes
y = output amplitudes

Dialog box options for the various filters are described below:

Filter type
User defined. Values for the C and D arrays are set by the user. This option is not recommended
for users unfamiliar with signal processing.

Frequency rejection (Carleton). Removes the frequency (specified in the Reject frequency box) 
from a time series using the methods described in WES Miscellaneous Paper N-70-1, Digital 
Filters for Routine Data Reduction, by H.D. Carleton.

Frequency rejection (Press). Removes a narrow frequency band from a time series using the 
procedures described in Numerical Recipes, Cambridge University Press, by W.H. Press, B.P. 
Flannery, S.A. Teukolsky, and W.T. Vetterling. The frequency to remove is specified in the Reject 
frequency box. The width of the frequency band to remove is specified in the Bandwidth box.

Zero frequency rejection. Removes an offset from an oscillating time function using method 
described in WES MP N-70-1.

Option x low-pass. The four low-pass filters are described in WES MP N-70-1. These filters 
each use the linear filter equation described above, but make multiple passes using different filter 
coefficients.

Random spike removal. The Random spike removal method is the only filtering technique used 
by DPLOT that does not use the linear filter described above. This method is useful for removing 
single samples with high amplitudes which bear no relation to the true record. DPLOT uses a 
slightly modified method from that described in WES MP N-70-1. The main condition defining a 
spike is:

The above inequality states that the ratio of the two sides of a spike must be nearly unity. The condition 
which defines the sizes of spikes to be removed is:

where Range is the current range in amplitudes for the record. If any sample in a record meets both of the
conditions described above, it is considered a spike and replaced with the average of the adjacent values.

Reject frequency
Is used only by the two Frequency rejection filters. This box is disabled for all other filters.



Bandwidth
Is used only by the Frequency rejection (Press) filter. This box is disabled for all other filters.

Time scale
The time scale is important for each of the Frequency rejection filters, since the coefficients C and D are
dependent on the sampling frequency of the input.

Two pass
Each of the filtering methods used by DPLOT introduce a small phase shift to the input record. This 
situation may be corrected by selecting the Two pass option, which repeats the filtering operation in time-
reversed order.

Replace data
Check this box to replace the existing record with the filtered data. Leave this box unchecked to produce 
a new curve. This option is disabled in data processing mode (the existing record is always replaced).

Filter coefficients
These controls are disabled for all but the User defined filter. The coefficients used by DPLOT for each of
the next three filters (frequency rejection and zero frequency rejection) are shown but cannot be edited 
directly.



    Baseline Shift command (Edit menu)

Allows you to specify a new value at a specific time in a record generated from the primary data file in 
"data processing" mode.

If the Constant Baseline Shift checkbox is checked, then the shift is applied to all points in the primary 
record. Otherwise, you may specify a start time and end time.

The start time must be less than the time at which you want the integrated record to match the value you 
specify.

After altering the primary record, DPLOT will automatically regenerate integrated records and, if the shift 
is applied to all points, will update the CBS display in the title.

DPLOT maintains a list of all shifts applied to the primary record, which can be displayed with the 
List     Editions   command.

 ____________________________
See also

Data Processing



    List Editions command (Edit menu)

Displays a list of baseline shifts made to the primary data record in "data processing" mode. Includes 
shifts made with either the "Add a constant to Y" or "Baseline Shift" commands.

____________________________
See also

Edit Menu
Data Processing



    Smooth command (Edit menu)

Smooths the amplitudes for a selected curve.

The abscissas for the selected curve must be monotonically increasing and evenly spaced.

The Smooth command removes any linear trend to the data so that the first and last amplitudes are zero, 
uses a Fast Fourier Transform to low-pass filter the data, and finally reinserts the linear trend to the 
amplitudes.

The smoothing window is the number of points over which the data should be smoothed. Zero gives no 
smoothing at all, while a value approaching half the number of data points will render the data virtually 
featureless.

The algorithm used by the Smooth command is taken from Numerical Recipes by Press, Flannery, 
Teukolsky, and Vetterling. This reference includes the following qualification:

Data smoothing is probably most justified when it is used simply as a graphical technique, to 
guide the eye through a forest of data points all with large error bars. In this case, the individual 
points and their error bars should be plotted on the same graph, and no quantitative claims 
should be made on the basis of the smoothed curve. Data smoothing is least justified when it is 
used subjectively to massage the data this way and that, until some feature in the smoothed 
curve emerges and is pounced on in support of an hypothesis.

____________________________
See also

Fast Fourier Transform



    Equal Intervals command (Edit menu)

Generates a new curve with a constant spacing on the abscissa (X axis). This command is useful for 
generating evenly spaced data points prior to performing some function that requires this characteristic 
(FFT for example). It may also be used to generate a smooth curve through widely spaced data points.

This command uses one of four methods for interpolating amplitudes between existing data points. The 
Linear, Quadratic, and Cubic Interpolation methods use, respectively, 1st, 2nd, and 3rd order polynomials.

Polynomial interpolation uses a finite number (2,3, or 4) of "nearest neighbor" data points to give 
interpolated values of the input record. In general, the interpolated values do not have continuous first or 
higher derivatives. That happens because, as X crosses the tabulated input values, the interpolation 
scheme switches which input data points are used to derive the polynomial interpolating function. If 
continuous first and second derivatives are important the Cubic Spline method should be used. The cubic 
spline implemented by DPLOT sets the second derivatives at each end of the input record to zero.

Select the Replace existing curve checkbox to replace the original curve with the evenly spaced data. 
Leave the box unchecked to preserve the original data.











    Error Messages

Following is a description of selected error messages displayed by DPLOT, with suggested corrective 
action.

Clipboard Errors
Unable to open Windows clipboard.
OR
Unable to access clipboard ... try again later.

Either 1) another application is currently accessing the Clipboard (unlikely), or 2) another application 
failed to release control of the Clipboard after performing a cut/paste operation (more likely). Try again 
after a short delay. If this error message is repeated the only solution is to exit and restart Windows.

Data was successfully transferred, but the maximum number of points was exceeded.    DPLOT was 
unable to copy all of the data from the clipboard.    You may use the File:Resize Arrays command and try 
again.

DPLOT reads data from the Clipboard in one pass (for speed), so that it is not known how many data 
points are on the Clipboard until the points are actually transferred.

Memory Allocation
Insufficient memory for temporary storage.

Many DPLOT functions require temporary storage for working variables. DPLOT attempts to 
dynamically allocate memory for these temporary variables, and frees this memory when the function 
is complete. Under low memory conditions this procedure may fail. Close other active applications, if 
any, and try again. If no other applications are open, or if closing the applications does not solve the 
problem, set the array sizes for all current plots to the smallest possible values (maximum number of 
curves = current number of curves, maximum number of points = maximum number of points in any 
existing curve) using the Resize Arrays command on the File menu.

There is not sufficient disk space to temporarily store the existing data while resizing the X,Y arrays. See 
'Error Messages' in Help.

It is possible that the addition of new data to an existing plot (either by reading a file or generating new
data) would exceed the current array sizes (shown on the status bar and set with the Resize Arrays 
command). In this case DPLOT attempts to first save the existing data to a temporary file, destroy the 
arrays, re-allocate the arrays with the new required size, and read the existing data back into memory 
from the temporary file. If there is not sufficient disk space to store the existing data this operation will 
fail. However, unlike the condition causing the following error message, DPLOT does successfully 
restore the existing data. DPLOT uses the drive set with the TEMP environment variable for the 
location of temporary files. If the TEMP environment variable is not set, DPLOT uses the drive where 
Windows is located. Set the TEMP environment variable to the drive with the most free disk space 
(hopefully corresponding to your fastest drive).

Unable to restore arrays. Closing DPLOT. Call (601) 634-3668.
When attempting to resize the arrays as described above, if DPLOT cannot allocate the arrays with 
the new required size, it attempts to restore the previous array sizes. Failure of this operation generally
indicates serious memory problems (which may or may not have been caused by DPLOT). It is 
possible that a second active application has consumed some amount of memory between the times 
that DPLOT destroys the original arrays and attempts to restore these arrays. Whatever the cause, if 
this condition occurs DPLOT will terminate.

Scaling Errors
Manually entered window coordinates are not consistent with logarithmic scaling.

One or more of the plot extents set with the Manual Scale command are less than or equal to zero. 
Change the plot extents using the Manual Scale command on the Options menu.

Manually entered window coordinates are not consistent with a probability scale.
One or more of the plot extents set with the Manual Scale command are either less than or equal to 0, 



or greater than or equal to 100. Change the plot extents using the Manual Scale command on the 
Options menu.

Acceleration values exceed the limits of a single precision real number.    A tripartite grid is not 
appropriate.
OR
Deflection values exceed the limits of a single precision real number.    A tripartite grid is not appropriate.

Though the frequency (X) and velocity (Y) values are valid for a logarithmic scale, the associated 
acceleration or displacement values fall outside the limits of a single precision (4 byte) real number 
(approximately 1.2E-38 to 3.4E38).

No range for x values. (Xmin = Xmax)
OR
No range for y values. (Ymin = Ymax)

These errors are generally associated with attempting to plot a single data point. At least two data 
points are required.



    File Menu

New 
Opens a new document window.

Open... 
Opens a new document window; reads data from a file

Append... 
Adds data from file to existing document window

Close 
Closes the currently active document window.

Save 
Saves the active document's data in a DPLOT file.

Save As... 
Saves the active document's data.

Get Preferences...
Retrieves plot settings from a previously saved file.

Save Preferences...
Saves plot settings (line and symbol styles and sizes, scaling, etc.) to a file.

Print... 
Displays a Print dialog box; prints the current plot

Page Setup... 
Changes the margins for a hard copy.

Macro... 
Build and/or run a macro file to perform unattended operations.

Resize Arrays... 
Changes the maximum number of curves and points per curve.

Exit 
Quits DPLOT



    New command (File menu)

Opens a new document window.

DPLOT attempts to allocate arrays for the X,Y data pairs using the maximum number of curves and 
points last entered using the Resize Arrays command. If there is not sufficient memory for allocating those
arrays, DPLOT presents an error message explaining the problem. You may correct the problem by:

1) Entering smaller values for either or both of the number of curves and number of points, then 
selecting OK.

2) Select Cancel, close one or more document windows, and select New again.

Shortcut:
Click        on the toolbar.
CTRL+N



    Append command (File menu)

Adds data from a file to the currently active document window. For DPLOT format files the Append 
command is equivalent to a combination of the Close and Open commands ... all existing data is erased.

The current maximum number of curves (set with the Resize Arrays command) must be greater than the 
number of existing curves to add new data without erasing old curves.

____________________________
See also:

Resize Arrays 



    Open command (File menu)

Allows you to open a DPLOT file (containing data, strings, and formatting information), or one or more of 
nine other file formats.

Shortcut:
Click        on the toolbar.
CTRL+O

A) DPLOT file    Contains data for one or more curves, as well as the title, axis labels, legend, and 
other formatting information.

B) ASCII file, one data set with arbitrarily spaced points. The    first line should have the number of 
points (N). Subsequent lines should contain each of the N X,Y data pairs.

Example:
5
1. 1.
2. 4.
3. 9.
4. 16.
5. 25.
View 

C)  The first line should have the number of points (N); the second line should have the spacing 
between data points (DX). The Y values may be on the same line separated by one or more spaces, or on
separate lines. The first X value is assumed to be 0. (This can be amended by selecting 'Add a constant 
to X' from the 'Edit' menu.)

Example:
6
1.
0. 1. 4. 9. 16. 25.
View 

D)  Optionally, the file may include a title line in the first line of the file and axis labels or legend 
character strings in the line immediately preceding the start of the data.

Example:
1.00 1.00 1.00 1.00
2.00 4.00 8.00 16.0
3.00 9.00 27.0 81.0
4.00 16.0 64.0 256.
5.00 25.0 125. 625.
View 

If the file consists of a single column of data DPLOT interprets the data as Y values, setting the 
corresponding X values to the index of the Y value in the file, starting from 0. Otherwise, DPLOT uses the 
first column of data for the X array and subsequent columns as separate Y arrays.

E) Unformatted data. Unformatted data files are generally much smaller than their equivalent ASCII 
files, and read/write operations are generally an order of magnitude faster. DPLOT writes the file as a 
series of 1024-byte records, with the 1st record containing only the number of data points (4 byte integer),
and subsequent records consisting of 128 x,y pairs each. The first four bytes of the first record are the 
only bytes that are significant, and the remainder should be disregarded. The following lines of code, 
when compiled with the Ryan/McFarland or Microsoft FORTRAN compilers, will read a file produced by 
DPLOT in this manner:



      integer*4 np
      real*4    x(5000), y(5000)
      open(unit=8,file=fname,
     &     access='DIRECT',recl=1024)
      read(8,rec=1) np
c
c Guard against array overflow:
c
      np = min0(np,5000)
      nrec = int( (np-1)/128) + 1
      do 1 i = 1,nrec
        j1 = (i-1)*128+1
        j2 = min0(np,i*128)
        read(8,rec=i+1)
     &      (x(j),y(j),j=j1,j2)
 1    continue
      close(8)

Note that this method will always produce a file size of at least 2048 bytes, regardless of how small the 
original data set is. If you use the Lahey FORTRAN compiler and you want to read an unformatted file 
produced by DPLOT, you should compile your program with the /D option, which tells the program not to 
expect the F77L header. Likewise, if your F77L program produces an unformatted file that you want to 
read with DPLOT, the program should be compiled with the /D option.

Other FORTRAN compilers may expect different file formats for unformatted data than that described 
above.

F) Binary file produced by Pacific Data Model 9820 recorders, DNA/Bendix format. Records produced 
in DNA field tests generally follow this format. See your instrumentation personnel.

G) Binary file produced by Pacific Data recorders, WES/ISD OLD format. Explosive tests performed at 
WES and in WES field tests prior to 1993 generally follow this format. See your instrumentation 
personnel.

H) Binary file produced by Pacific Data recorders, WES/ISD NEW format. Explosive tests performed at
WES and in WES field tests starting in 1993 generally follow this format. See your instrumentation 
personnel.

I) Nicolet Time Domain files (binary) created with the Nicolet System 400 Digital Oscilloscope.

J) Hardened Data Acquisition System (HDAS) files. The HDAS is a self-contained 
transducer/recording system developed by Dr. Ray Franco of the Instrumentation Services Division at 
WES.

Array sizes
If the current maximum number of points/curve is less than the number required to read the file, DPLOT 
will attempt to re-allocate the X,Y arrays using the power of 2 greater than or equal to the number of 
points found in the file, and the number of curves specified in the file. If the re-allocation fails, DPLOT 
presents an error message and/or reads only the allowable number of points.
If, after successfully reading a file, the allocated number of points/curve is greater than twice the number 
required, DPLOT re-allocates the X,Y arrays using the power of 2 greater than or equal to the maximum 
number of points for all curves.

Multiple file selection
For other than DPLOT files, you may read multiple files into the same window. To select multiple files, 



hold down the CONTROL key while selecting each of the files to read, or press the SHIFT key to select a 
range of files.

Separators
For each of the supported ASCII file formats, data values may be separated by one or more spaces or a 
comma, but not a <TAB> character. The last line in the file should include a carriage return/line feed 
sequence.

Time scale
Input time values for binary files (file types F, G, H, I, and J) are automatically shifted to milliseconds, 
rather than seconds.









    DPLOT File

A DPLOT file is an ASCII text file containing all of the information DPLOT needs to fully reproduce a 
finished plot. The first line in the file contains a header that informs DPLOT of the file version. The second 
line contains a keyword that describes what follows. The general form of a DPLOT file follows:

DPLOT v1.0
keyword 
nCurves 
do i = 1 to nCurves

keyword-specific data
LineStyle(i), SymbolStyle(i) 
Legend(i) 
CurveLabel(i) 

end do
Title(1)
Title(2)
XAxisLabel
YAxisLabel
ScalingCode 
LegendX, LegendY 
Other miscellaneous identifiers 

If the maximum number of curves (set with Resize arrays) is less than the number of curves specified in 
the file, DPLOT will automatically adjust the size of the X and Y arrays so that: 1) the maximum number of
curves is equal to the number of curves specified in the file; and 2) the maximum number of points is 
greater than or equal to the maximum number of points for any one curve. This feature may require 
DPLOT to read the file several times before finding the minimum array sizes.

The file header is a recent addition to the DPLOT file format that assists DPLOT in immediately identifying
a file. Older DPLOT files will continue to work with DPLOT.

____________________________
See also:

Resize arrays 



nCurves
Integer. Number of    data sets, or curves, that follow.



CurveLabel(i)
Character string. Short description of the i'th curve, generally placed near the last data point in the curve.



Legend(i)
Character string. Descriptive text for the i'th curve, where i ranges from 1 to nCurves 



LineStyle(i), SymbolStyle(i)
Integers. The line style and symbol style codes for the i'th curve, where i ranges from 1 to nCurves    
DPLOT currently supports 6 different line styles and 12 different symbol styles. A value of 0 indicates no 
lines ( or no symbols).



    Scaling Code

The low byte of the scaling code indicates what type of scaling the plot should use. Currently supported 
values are:

1 Linear X, Linear Y
2 Linear X , Logarithmic Y
3 Logarithmic X, Linear Y
4 Logarithmic X, Logarithmic Y
5 Tripartite grid
6 Linear X - Probability Y
7 Grain Size Distribution
8 Polar coordinates
9 Bar chart
10 Logarithmic X, Probability Y
11 Probability X, Linear Y
12 Probability X, Logarithmic Y
13 Probability X, Probability Y

The high byte of the scaling code contains scaling-specific information. Currently, this value is used only 
for tripartite grids, grain size distributions, and polar coordinates. For all other scale types, this value is 
reserved for future use and must be 0.

Tripartite grids
The high byte indicates what units to use for the grid. Currently supported values are:

Units
Code

Scaling
Code

0 5 Hz, inches/sec, inches, and g's
1 261 Hz, feet/sec, feet, and g's
2 517 Hz, mm/sec, millimeters, and g's
3 773 Hz, cm/sec, centimeters, and g's
4 1029 Hz, meters/sec, meters, and g's

127 32517 User-defined units.

Grain size distributions
The high byte indicates what units the grain sizes are in. Currently supported values are:

Units
Code

Scaling
Code

0 7 Millimeters
1 263 Inches

127 32519 User-defined units

Polar coordinates
The high byte indicates what units the angular dimensions are in. Currently supported values are:

Units
Code

Scaling
Code

0 8 Radians
1 264 Degrees



A DPLOT file saved with "user-defined" units should also contain the miscellaneous identifier "units".
____________________________
See also:

Linear/Log scaling 
Miscellaneous identifiers 



LegendX, LegendY
Floating point. The X and Y position of the upper left corner of the legend, expressed as a ratio of the 
graph's dimensions. ( 0,0 would place the legend in the upper left corner of the plot, 0.5,0.5 places the 
upper left corner at the center of the plot).



    DPLOT file keywords

Following is a list of all of the keyword identifiers currently supported by DPLOT. For keywords used to 
generate data (all but "data" and "dx"), DPLOT generates up to the minimum of 200 data points or the 
maximum number of points (specified with the Resize Arrays command). The spacing between data 
points is dependent on the type of scaling used. On linear scales, the data will be evenly spaced. On 
logarithmic scales, the data will appear to be evenly spaced.

data
File consists of data points.
keyword-specific data:

nPoints(i)
do j = 1 to nPoints(i)

x(j,i), y(j,i)
end do

dx
Data points (Y values only) with constant spacing between x values
keyword-specific data:

nPoints(i)
do j = 1 to nPoints(i)

y(j,i)
end do
XStart(i), XStop(i)

poli
Polynomial: y    = C(1)+ C(2)x + C(3)x^2 + C(4)x^3 + ... 
keyword-specific data:

nTerms(i)
do j = 1 to nTerms(i)

C(j)
end do
XStart(i), XStop(i)

poly
Polynomial: y = C(1)x^Z(1) + C(2)x^Z(2) + .... 
keyword-specific data:

nTerms(i)
do j = 1 to nTerms(i)

C(j,i), Z(j,i)
end do
XStart(i), XStop(i)

expo
Exponential: y    = exp[C(1)x^Z(1) + C(2)x^Z(2) + ... ]. Keyword-specific data has the same form as that for
"poly".
    
exp2
Exponential: y    = C(1) + C(2)exp[C(3)x]
keyword-specific data:

C(1,i), C(2,i), C(3,i)
XStart(i), XStop(i)

pl10



Common logarithm: y    = C(1)+ C(2)log10(x) + C(3)(log10(x))^2 + ... Keyword-specific data has the same 
form as that for "poli".

plog
Common logarithm: log10(y) = C(1)+ C(2)*log10(x) + C(3)*(log10(x))^2 + ... Keyword-specific data has 
the same form as that for "poli".

slog
Semi-log: log10(y) = C(1)x^Z(1) + C(2)x^Z(2) + .... Keyword-specific data has the same form as that for 
"poly".

In addition, modifiers may be applied to alter the data generated with the keywords listed above (for
all but "data").

____________________________
See also:

Keyword modifiers 



    DPLOT file keyword modifiers

Data points generated with any of the DPLOT keywords other than "data" may be modified using one of 
the methods specified below. Modifiers are applied to all curves in the file, and the modifier keyword must 
occur before the more general keyword identifier.

invr
Inverse of the function; i.e. y = 1/y

plus
Adds a constant to result; i.e. y = y + A. Constant A should be located immediately before the XStart and 
XStop values, and after the constants associated with "mult" if it is used.

mult
A constant times the function to a power; i.e. y = B * y^C. Constants B and C should be located 
immediately before the XStart and XStop values.

log
the common logarithm of the function; i.e. y = log10(y)

logn
the natural logarithm of the function; i.e. y = log(y)

These modifiers may be combined. The order of precedence for a file containing all modifiers is: y = 1/ ( B
( log(y)+A )^C )



    DPLOT file miscellaneous identifiers
 
Miscellaneous identifiers in a DPLOT file consist of a descriptive keyword followed by associated data, if 
any. A description of each of the currently supported miscellaneous identifiers follows:

Cal
Followed by the gage calibration value. Used in the title for data processing mode.

DenseGrid
Turns on dense gridline option (Options>Grid Lines or Box>Dense Grid Lines)

Date
If followed by a non-zero integer, date will be displayed in the upper-right corner of the plot.

FilledBars
Causes bar charts to be drawn with solid interiors (default is hollow).

FillRegion
Paints the area between two curves with a pattern. Followed by:
Curve1, Curve2, Style, Color, Hatch
where

Curve1 = index of first curve.
Curve2 = index of second curve.
Style = 0 for solid fill, 2 for a pre-defined pattern, or 3 for a user-defined pattern.
Color = Blue*65536 + Green*256 + Red, where each of Blue, Green, and Red range from 0 to 255.
Hatch = index of pre-defined patterns (ignored for Style not equal to 2)

0 = Horizontal lines
1 = Vertical lines
2 = 45 degree downward
3 = 45 degree upward
4 = Horizontal-Vertical cross-hatch
5 = 45 degree crosshatch

If Style = 3, the next line must contain a string of 8 1-byte hexadecimal values (no separator) describing 
an 8x8 pixel bitmap.

Example:
FillRegion
0001 0002 0003 00000255 0000
AA55AA55AA55

Fills the area between curves 1 and 2 with a red user-defined pattern consisting of every other dot turned 
on.

FontFace
Followed by:
FontIndex
FontFace
where

FontIndex is the index of the font.
1 = numbers on the axes,
2 = first title line
3 = second title line
4 = X axis label
5 = Y axis label



6 = legend or notation
FontFace is the name of the font to use; e.g., Times New Roman

Grid Type
Followed by the grid type to use. 0 = Axes only, 1 = Grid, 2 = Box. See Grid Lines or Box. 

LegendLineLength
Followed by the length of the line segment to use in the legend, in inches. The default line segment length
is 1/2 inch.

LineWidths
Followed by a list of line widths for each curve in the file, in hundredths of inches.

Lname
Followed by the title for the legend, which will be placed at the top of the legend. If no legend is present, 
"lname" may still be used to display miscellaneous text on the plot.

Manual Scale
Followed by the corner coordinates (in data space) of the plot window:
xlow, ylow, xhigh, yhigh
See: Manual Scaling 

Manual Ticks
Followed by the physical width and height of the plot and the number of tick mark intervals in the X and Y 
directions:
width, height, nXtick, nYtick
See: Set Physical Size 

Margins
Followed by the left, top, right, and bottom margins of a hard copy, in inches. See: Page Setup. 

MaxLegendRows
Followed by the maximum number of strings to place in a single column of the legend.

Multiple Axes
Followed by an option code and related data:
code
A, B if code = 1
AxisNumber(i),i=1,nplot if code = 2
where

code = 1 for a second Y axis dependent on the primary Y axis; = 2 for a second, independent Y axis.
A,B = coefficient for a 1st order polynomial that translates primary Y axis values to second Y axis 

values.
AxisNumber(i) = array of numbers associating curves with axes. AxisNumber(1) must be 1.

See: Multiple Y Axes 

NoLegendFrame
Turns off the default feature of drawing a rectangle around the legend.

NoteV2
Followed by:
X, Y, Flags, TabStop
Note\n
Note (cont.)\n
.
.



Note(cont.)

where
X,Y are the coordinates of the upper-left corner of the note, expressed as a percentage of the width 

and height of the plot.
Flags consists of a series of style bits that control how the note is drawn:

0x0002 A rectangular frame will be drawn around the note.
0x0004 The note will be opaque... any objects intersecting the note will be invisible.
0x0008 The note is activated by pressing a button.

TabStop is the character spacing between tab positions.

Each line of the note other than the last line should end in the sequence \n. DPLOT replaces \n with a 
<CR><LF> sequence when reading the note. There must be at least one additional line after the last 
occurrence of \n.

NoteButton
Followed by the text that appears on a button used to activate a note. By default, the button text is "Note".

NumberFormats
Followed by the number format codes for the X and Y axis.

PointSizes
Followed by:
NumFonts
Point(i),i=1,NumFonts

PtLabel
Prints a character string with an arrow directed toward a data point. Followed by:
CurveNum, PointNum, X, Y, Flags
Label
where

CurveNum, PointNum are the curve index and point within the curve associated with the label.
X, Y are the coordinates for the label, in plot space.
Flags consists of a series of style bits describing the appearance of the label:

0x0001 Label consists of the amplitude of the data point.
0x0002 Label will be opaque.
0x0004 A rectangular frame will be drawn around the label.

Label is the character string, ignored if Flags & 0x0001 = 0x0001.

SquareLogs
Forces physical distance between log cycles on the X and Y axis to be the same.

SymbolSizes
Followed by a list of symbol heights for each curve in the file, in hundredths of inches.

Title3
Followed by the third title line.

TransparentLegend
Turns off the default feature of hiding any objects that intersect the legend.

Units
For scaling options allowing the use of user-defined units, the constants used to convert input values to 
values associated with a particular scaling option, and the labels associated with those constants. 
Followed by:
A, B



LabelA
LabelB
where

A, B are the constants defined with the Units. command.
LabelA, LabelB are 16-byte character strings.

B and LabelB are ignored for grain size distribution plots.

wysiwyg
Turns on What You See Is What You Get style if the Set Physical Size command is used.

Y2Axis
Followed by a second Y axis label, to be placed along the right edge of the plot. Not displayed unless the 
Multiple Y Axes command is in effect.

Stop
Forces DPLOT to stop processing any other information in the file. This command is useful for developers
who wish to add their own information to a DPLOT file. DPLOT will always add the line stop to the end of 
a DPLOT file that it saves.



    Save command (File menu)

Use this command to save the active document in the DPLOT file format. When you save a document for 
the first time, DPLOT displays the Save As dialog box so you can name your document. If you want to 
change the name, location, or format of an existing document before you save it, choose the Save As 
command.

Shortcut:
Click        on the toolbar.
CTRL+S



    Save As command (File menu)

Saves either the entire plot, or a single curve's data.

Note: To save a DPLOT file with its existing name, format, and location, use the Save command.

DPLOT file 
Saves all data in addition to the title, axis labels, legend, and other formatting information.

ASCII file
Saves a file with the following form:
nPoints
x(1)    y(1)
x(2)    y(2)
        .
        .
x(nPoints)    y(nPoints)
DPLOT allows you to specify the number of significant figures (3 - 8) to use when saving the data. If
the data consists, for example, of whole numbers ranging from 1 to 100, you will waste disk space 
by saving more than 3 places. On the other hand, if the data range from 1000. to 1001., specifying 
3 places will result in a loss of all of the data's information content.

Unformatted
Saves the data as a series of 1024-byte records. Unformatted data files are generally much smaller 
than their equivalent ASCII files, and read/write operations are generally an order of magnitude 
faster. See Open command for more information.

Windows Metafile
Saves the entire plot in the Windows placeable metafile format. Placeable metafiles may be 
imported into a number of word processors and spreadsheet applications, or may be converted to 
another file format by many popular graphics conversion programs. DPLOT will not read a metafile.



    Close command (File menu)

Use this command to close the window containing the active document. DPLOT suggests that you save 
changes to your document before you close it. If you close a document without saving, you lose all 
changes made since the last time you saved it. You can also close a document by using the Close 
command on the document Control menu.

To close all open document windows, use the Close All command (hold down the SHIFT key and select 
the File menu).

Shortcut:
Double click the document Control menu icon.
CTRL+F4



    Print command (File menu)

The Print command allows you to alter the current printer setup and/or print the current plot.

Shortcut:
Click        on the toolbar.
CTRL+P

The initial printer settings are identical to those set with the Control Panel:Printers application. Changes 
in printer settings are preserved only during the current DPLOT session; DPLOT does not make 
permanent changes to the Control Panel settings, nor does it save printer settings for subsequent 
DPLOT sessions.

Dialog box Options
Multiple
Select the "Multiple" button if you want to print multiple documents on the same page. The active 
document MUST be printed. Placement of other documents on the page is controlled by the order
in which the documents are selected for printing. The spacing between documents is controlled 
by the value entered in the "Space between" box.

Print Quality/Speed Considerations
TrueType Fonts
If you use TrueType fonts in your plot, it may be necessary to check the "Print TrueType as 
Graphics" check box in the Print Setup or Print Options dialog box. Some printer drivers do not 
handle rotated TrueType text correctly unless it is converted to a graphic before printing.

Gray Scale and Color
For black and white printers, DPLOT simulates gray scales and colors with a dithered pattern. In 
order for the curve to be printed as expected, the line widths for the curves must be greater than 
0 (a single printer dot). The line width may be changed with the Symbol/Line Styles command 
under the Options menu. The color associated with each curve may be changed from the Colors 
menu.

Large Data Sets
Printing large data sets can take a VERY LONG time, depending on what options you have 
selected. You should consider decimating large data sets before printing. How large is large, you 
ask?    The following table lists timings for a plot consisting of about 120,000 points. It is not meant
as a benchmark of any kind, but should give you a rough idea of the effects of various plotting 
options. In each case, the timer was stopped when Print Manager was given the print job and 
control was returned to DPLOT.

Line width, inches Line Style Time
1/60 Other than solid 15 minutes

0 Other than solid 2.5 minutes
1/60 Solid 2 minutes

0 Solid 35 seconds

See Known Problems for a description of printing problems along with possible solutions. Problems not 
referenced in that topic should be referred to the author as described in the Technical Support topic.

____________________________
See also:

Fonts 
Decimate 



Symbol/Line Styles 
Colors 



    Page Setup command (File menu)

Displays a dialog box that allows you to specify the margins that will be used when printing a plot.

This command might be useful for:
· Hard copies that will be bound.
· Printing multiple plots on the same page.

The "Default" button resets all margins to 0.0 inches... the full extents of the printer will be used.



    Macro command (File menu)

Displays the Macro dialog box

Macro Name
Type or select the macro you want to run or edit.

Run
Runs the selected macro. The Run button is disabled if an existing macro is not selected.

Edit/Create
Opens a macro-editing window for a new macro whose name you type in the Macro Name 
box. If you select or type the name of an existing macro in the Macro Name box, clicking this button 
displays the contents of the selected macro in a macro-editing window for review or editing. This button is 
disabled if the Macro Name box is empty.

Delete
Deletes the selected macro. This button is disabled if an existing macro is not selected.

Cancel
Closes the dialog box.

____________________________
See also:

DPLOT Command Syntax



    Resize Arrays command (File menu)

Allows you to change the maximum number of curves that may be plotted, and the maximum number of 
data points per curve. Re-allocating the X and Y arrays requires first de-allocating those arrays. If one or 
more curves are currently present DPLOT issues a warning stating that the curve(s) may be destroyed. 
DPLOT attempts to save the current curve(s) to a temporary file, re-allocate the X and Y arrays, and then 
read the temporary file to restore the curve(s). This procedure may not be successful, though, if there is 
insufficient disk space to store the curve(s).

In general, DPLOT will automatically increase the size of the arrays when needed. However, DPLOT will 
run more efficiently if the array sizes are selected such that they will not need to be increased.

The maximum number of curves may not be greater than 20, but the maximum number of points per 
curve is limited only by the amount of free memory present on your machine.

Values entered with the Resize Arrays command will be used for the initial array sizes for any new 
document windows that are subsequently opened.

Shortcut:
Double click the "Max Size:" entry on the status bar.



    1, 2, 3, 4 command (File menu)
Use the numbers and names listed at the bottom of the File menu to open one of the documents you 
recently worked on (DPLOT File Format). Select the number or name that corresponds to the document 
you want to open.

____________________________
See also:

Open command 



    Exit command (File menu)

This menu option causes DPLOT to save default parameters to DPLOTW.INI and exit.

Shortcut:
ALT+F4



Generate Menu

This menu presents several options for generating new data based on one or more currently existing data
sets. Each of these commands produces a new curve (preserving the original curves).

Average All Curves
Finds average value at each abscissa for two or more curves.

Compare Curves
Find difference in amplitudes between two curves.

Curve Fit
Least-squares curve fit.

Integrate a Curve
Find area under curve.

Differentiate a Curve
Find slope of a curve.

Lump Two Curves
Add amplitudes of two curves to produce a third curve.

Y=Poly(Y)
Applies a polynomial transformation to the amplitudes of a curve.

FFT
Performs Fast Fourier Transform on a selected curve.

Histogram
Finds the frequency distribution for the amplitudes of a curve.

____________________________
See also:

Resize Arrays



Curve Fit command (Generate menu)

Shortcut:
Click     on the toolbar.

Uses least-squares curve fitting procedures to find the polynomial of a user-specified order that best fits 
the data. A least-squares curve fit is one in which the sum of the square of the errors between the actual 
data and the polynomial model are minimized:

 
DPLOT converts the input curve to a form most likely to achieve a good fit (or at least most likely to avoid 
scaling errors), depending on the type of scaling currently in effect. The actual form of the output 
polynomial is:

Correlation coefficient
The correlation coefficient presented by DPLOT is a measure of how well the polynomial fits the data. A 
correlation coefficient of 1.0 denotes a perfect fit, while a correlation coefficient less than 0.9 should 
probably be discarded. The correlation coefficient is described mathematically as:

Limitations
Attempting to generate a curve fit to a data set with a large number of data points (>1000) will sometimes 
cause an overflow error. In this case, it might be necessary to first reduce the data using one of the 
Decimate commands from the Edit menu.

In general, least squares curve fits are very poor predictors of trends in the data outside the limits of the 
input. Extrapolation outside the limits of the input is not recommended for any but 1st order fits. The figure



shown below illustrates the problem associated with extrapolating outside the limits of the input data. 
Even though the generated curve fits the input perfectly, values outside the limits of the data are, at best, 
suspect.

Bear in mind that the least squares procedure operates only on existing data points. A generated curve fit 
might fit the data points exactly, but produce completely unexpected results between data points. This is 
particularly true for high order polynomials. As in the figure above, the generated curve in the figure below
fits the input data precisely. However, in this case, a 1st or 2nd order fit would produce a much more 
realistic model of the input data, even though the resulting polynomial would not be perfectly correlated.

____________________________
See also:

Decimate 





Integrate a Curve (Generate menu)

DPLOT finds the area under a curve using the trapezoidal rule:

Typical uses for integration include generating an impulse-time history from a pressure-time record, or 
velocity-time from acceleration-time.

Shortcut:
Click     on the toolbar.



Differentiate a Curve (Generate menu)

Two methods are available for differentiating (finding the derivative of) a curve. Typical uses for 
differentiating a curve include generating a velocity-time history from a displacement-time record, or 
pressure-time from impulse-time.

Trapezoidal rule
The trapezoidal rule inverts the process used by the Integrate a Curve command. This is the only method 
available for differentiating curves that do not have a constant spacing in X. 

Note that, unlike numerical integration using the trapezoidal rule, differentiation is not always a stable 
process. Small roundoff errors in early time steps are propagated and amplified through the entire record. 
This is especially critical in records with a large number of data points.

Quadratic interpolation
This method tends to be much more stable than the trapezoidal rule, but requires that the input data have 
a constant spacing. DPLOT uses a quadratic interpolating function that fits the amplitude at a given time 
step plus its nearest two neighbors and sets the derivative at this time equal to the slope of the 
interpolating function. Note that this method does not use previously calculated derivatives, so earlier 
roundoff errors are not carried forward.

____________________________
See also:

Integrate a Curve



FFT command (Generate menu)
Shortcut:

Click     on the toolbar.

Performs a Fast Fourier Transform (FFT) on a selected data record. The input data must be evenly 
spaced (have a constant interval). Unlike the other Generate commands, the FFT command creates a 
new document window for displaying the output, since the input and output records are in different 
domains.

Given a function of time h(t) with N consecutive sampled values, the FFT implementation used by DPLOT
calculates the corresponding function in the frequency domain as:

DPLOT can use either of two FFT algorithms, dependent on the number of points (N) in the input record:

REALFT
Source: "Numerical Recipes" by W.H. Press, B.P. Flannery, S.A. Teukolsky, and W.T. Vetterling, 
Cambridge University Press, 1986.

REALFT requires that the number of points (N) in the input record be a power of 2.

EZFFTF
Developed by P.N. Swarztrauber, National Center for Atmospheric Research, Boulder, CO. Available 
on the World Wide Web at the NETLIB Repository, http://netlib2.cs.utk.edu.

EZFFTF does NOT have the same limitations on N, but can take significantly longer to compute the 
transform (see below).

The efficiency of the EZFFTF algorithm is highly dependent on the magnitude of the prime factors of N. 
For small prime factors, this routine is comparable in performance to the REALFT algorithm. However, for 
large prime factors, or for N equal to a large prime number, the run time of this routine can be several 
orders of magnitude longer than that for a comparable N consisting of small prime factors. The following 
table (based on a Pentium 90 MHz system) illustrates this fact.

N Prime Factors FFT Run Time

16384 2^14 0.11 sec
16379 19*431 1.00 sec
16381 prime 97. sec

65536 2^16 0.50 sec
65521 prime ~33 minutes

If N is not a power of 2, you can elect to pad the input record with 0 values out to the next higher power of
2 by selecting the first option in "Adjustment Options" in the "FFT Options" dialog box. This operation will 
significantly decrease the run time for FFT's on input records with N equal to a large prime.

If N is a power of 2, DPLOT will always use the REALFT routine, regardless of the option selected.

If you are reasonably certain that you will always select the same options for performing an FFT, you can 
prevent the "FFT Options" dialog box from being displayed by selecting the "Don't show this dialog box..." 



check box. If you later decide that you need to change one or more options, exit DPLOT, edit the file 
DPLOTW.INI (in the Windows directory), and find the line "FFTOption=0xnnnn", where nnnn is a 
hexadecimal number. Set this value to 0x0001 and start DPLOT.

X axis units
If data processing mode is currently in effect DPLOT assumes that the X values are in units of 
milliseconds. Otherwise, DPLOT scans the X axis label for the character strings "msec" or "millisec" (any 
combination of lower and upper case). If found, DPLOT assumes that the X values are milliseconds; 
otherwise seconds are assumed. The units of time are important only in determining the correct units for 
the frequency scale. If the assumptions described above are incorrect, then the frequency label for the 
FFT will be incorrect. For example, if the input is in milliseconds but DPLOT incorrectly assumes seconds,
the frequency values will be kilohertz rather than hertz.



Y=Poly(Y) command (Generate menu)

This command applies a polynomial transformation to the amplitudes of a curve. The new curve has the 
form:



    Histogram command (Generate menu)

Use the Histogram command to plot the frequency distribution of the amplitudes of a selected record. The
Histogram command creates a new document window.

DPLOT initially suggests a sampling interval such that:

where
k = number of sampling intervals
n = total number of samples
This is the sampling interval suggested by H.A. Sturges in "The choice of a class interval," Journal of 
American Statisticians Association, vol. 21, 65-66, 1926



Y=f(X) command (Generate menu)

This command allows you to create a curve that consists of data generated by a function Y of X. This 
feature requires that QBASIC.EXE be in your search path.

After you select "OK", DPLOT generates a BASIC source code file in your temporary directory and 
launches QBASIC.EXE. The BASIC source code generated by DPLOT writes to a temporary file the 
values generated by the function that you enter. Data points will be evenly spaced on the X axis between 
the values specified by "from X=" and "to X=". After the successful completion of the BASIC program, 
DPLOT reads the X,Y data pairs from this temporary file, then deletes both the temporary file and the 
BASIC source file.

For example, with the following input:

f(x) Y=sin(PI*X)

Constants PI=4.0*ATN(1.0)

from X= 0.0

to X= 2.0

with interval dX= 0.001

DPLOT generates the following BASIC source file:
' This source code was generated by DPLOT.
' The file containing this code (C:\TEMP\~DPL2E62.TMP)
' will be erased by DPLOT upon completion.
OPEN "C:\TEMP\~DPL2E67.TMP" FOR OUTPUT AS #1
PRINT "Generating data; please wait"
' Constants
PI=4.0*ATN(1.0)
PRINT #1,        2001
FOR I = 1 TO         2001
X =        0.0000000 +        0.0010000* (I-1)
Y=sin(pi*x)
PRINT #1,X,Y
IF I MOD          100 = 0 THEN PRINT I," POINTS"
NEXT I
CLOSE #1
SYSTEM

resulting in the following plot:



Note: If Windows 95 has been installed on your system, QBASIC.EXE may not be on your hard disk. 
However, QBASIC.EXE may be found on the original Win95 CD in the \other\oldmsdos directory. If this is 
the case, you can copy QBASIC.EXE from the Win95 CD to any directory on your hard disk that is in your
search path, or to the DPLOT directory.



    Info Menu
List peak values

Displays a dialog box listing minimum and maximum amplitudes and the point at which they occur.
Shortcut:

Click     on the toolbar.

Interpolate...
Reports an interpolated amplitude for each curve at a user-specified abscissa.

Scan X, Y
Displays data values for a single curve as you scroll through the data.

Find Baseline
Finds the average amplitude between a user-specified range of points. Useful for performing baseline
shifts.

Number of Points
Reports the number of data points in each curve.



    Interpolate command (Info menu)

Shortcut:
Click     on the toolbar.

Interpolates between data points and reports an interpolated amplitude at a user-specified abscissa. The 
method of interpolation is dependent on the type of scaling in use. On a linear scale, linear interpolation is
used. On a logarithmic scale, linear interpolation is performed on the logarithms of the data points, and 
the inverse logarithm of the interpolated value is reported.

Note that you may get wildly different answers between one scaling type and another, particularly if the 
data points are widely spaced. An example of this apparent discrepancy is illustrated by the following two 
figures.





    Scan X, Y command (Info menu)

Shortcut:
Click     on the toolbar.

Displays data values for a single curve as you scroll through the data. Unlike many other DPLOT 
features, this command relies on the abscissa (X) values increasing monotonically; i.e. the data can be 
represented by a single-valued function. With curves that loop back on themselves (moment-thrust 
interaction diagrams, for example), you may not be able to scan through all visible points.

The Scan dialog box will report values that lie between the plot window's minimum and maximum X 
values, including values that lie either above or below the plot window.

Clicking on the scroll bar's right arrow, or pressing the <Right> or <Down> arrow keys, increments the 
index in the array by the value specified in the Increment box. Clicking on the scroll bar's left arrow, or 
pressing the <Left> or <Up> arrow keys, decrements the index. The increment (initially 1) may be 
increased or decreased by a factor of 10 by clicking on the spin button arrows.

Clicking on the area to the left or right of the scroll bar "thumb", or pressing the <PgUp> or <PgDn> keys, 
moves the pointer by 5% of the number of points lying between the first and last points visible on the 
screen.

It may be necessary to zoom in to an area of interest to force the scroll bar to behave in a useful manner, 
particularly if the data record contains a very large number of points.

____________________________
See also:

View Menu



    Specifying a file on the command line

DPLOT may be forced to automatically read and display a file when first started by specifying the full path
and name of the file on the command line. From Program Manager, select File, then Run... , and type:

DPLOTW.EXE [/Fn]=[d:][\path\]filename.ext

where n is the file type code, described below. If /Fn is omitted, DPLOT attempts to determine the file 
type with the following assumptions:

If Then DPLOT assumes the file is:
The first line of the file contains the DPLOT file header 
(DPLOT vxx)

DPLOT file (type 1)

The file contains fixed width columns of data type 4

The first three characters of the filename are 'TDR', and
the extension is '.30'

type 7

The first three characters of the filename are 'TDR', and
the extension is not '.30'

type 8

The filename extension is '.WFT' type 9

File type codes
1 DPLOT file
2 ASCII file, one data set with arbitrarily spaced points.
3 ASCII file, one data set with evenly spaced points.
4 ASCII file, fixed width columns with multiple Y values for each X.
5 Unformatted data.
6 Binary file produced by Pacific Data Model 9820 recorders, DNA/Bendix format.
7 Binary file produced by Pacific Data recorders, WES/ISD OLD format.
8 Binary file produced by Pacific Data recorders, WES/ISD NEW format.
9 Nicolet Time Domain files (binary) created with the Nicolet System 400 Digital 

Oscilloscope.
10 Hardened Data Acquisition System (HDAS) files.

File types are described in more detail in the description of the Open command command.

____________________________
See also:

DPLOT File
Display/Print DPLOT File from File Manager



    Display or print a DPLOT file from File Manager/Explorer

The SETUP program automatically associates files with a .GRF extension with DPLOT.

Windows 3.x
To open a file with a .GRF extension while in File Manager:
· Double-click on the selected filename, or
· Select the filename, then choose Open from the File menu.

To print a file with a .GRF extension while in File Manager, select the filename, then choose Print from the
File menu.

To associate files with extensions other than .GRF with DPLOT:
1 Select the name of the file you want to associate with DPLOT. 
2 From the File menu, choose Associate. 
3 In the Associate dialog box, select DPLOT File. 
4 Choose the OK button. 

Windows 95/Windows NT 4.0
To open a file with a .GRF extension while in Explorer:
· Double-click on the selected filename, or
· Select the filename, click the right mouse button, then select Open from the menu.

To print a file with a .GRF extension while in Explorer, select the filename, click the right mouse button, 
then choose Print.

____________________________
See also:

DPLOT File
Drag-and-Drop



    Drag-and-Drop files from File Manager

You can select a file in the File Manager (or any other drag-drop source), drag it outside of the File 
Manager's window, and drop it onto DPLOT's window. When you drop files from the File Manager onto 
DPLOT running either as an icon or in it's normal (restored) state, DPLOT opens the file dropped onto it. 
DPLOT attempts to determine the file type as described under Specifying a File on the Command Line.

You can select several files at once using the CTRL key and drag them all with the mouse. Each file will 
be opened in a separate document window within DPLOT.

____________________________
See also:

DPLOT File



    Status Bar description

The status bar is displayed at the lower edge of the DPLOT window:

                        STATUS                                                            ARRAY SIZE

STATUS is used to:
· prompt you for an action;
· describe the current procedure;
· describe the screen region pointed to by the mouse;
· display the X,Y coordinates of the mouse pointer in plot space;
· indicate progress during lengthy operations.

ARRAY SIZE indicates the maximum allowable number of curves and the maximum allowable number of 
points per curve. These values may be adjusted with the Resize Arrays command.

____________________________
See also:

Resize Arrays



    Using WinExec to plot an existing File

The following code fragment (in FORTRAN) demonstrates a method for instructing DPLOT to plot an 
existing file from within another Windows-based program.

      integer*2 hWndDPLOT         ! Handle of DPLOT window
      integer*2 hInstDPLOT        ! Instance handle of DPLOT module
      integer*2 wStatus           ! API return code
      integer*4 hKey              ! Registration database key
      integer*4 dwLength          ! String length
      character szFileName*80     ! Null-terminated string containing
                                  ! name of file to plot.
      character szDPLOT*256       ! Full d:\path\filename.ext
                                  ! of DPLOTW.EXE
      .
      .
      hWndDPLOT=FindWindow('DPLOT/W'c, NULL_POINTER)
      if (hWndDPLOT.eq.0) then
c
c        DPLOT is not currently running. Check user's
c        registration database for location.
c
         wStatus = RegOpenKey( HKEY_CLASSES_ROOT,
     1                         'DPLOTW\shell\open\command'//char(0),
     2                         hKey )

         if( wStatus .eq. ERROR_SUCCESS ) then
c
c           DPLOT's location is in the
c           registration database... now retrieve it.
c
            dwLength=len(szDPLOT)
            wStatus=RegQueryValue( hKey, NULL_POINTER,
     1                            szDPLOT, dwLength )
            wStatus=RegCloseKey( hKey )

         else
c
c           No mention of DPLOT in registration
c           database. Possibly the user has
c           modified and/or deleted the database.
c           Look in DPLOTW.INI for location.
c           If not mentioned there, filename defaults
c           to 'DPLOTW.EXE'in the current directory.
c 
            wStatus = GetPrivateProfileString(
     1                         'Files'//char(0),
     2                         'ProgramDir'//char(0),
     3                         char(0),
     4                         szDPLOT,
     5                         len(szDPLOT),
     6                         'DPLOTW.INI'//char(0) )
            szDPLOT(wStatus+1:)='DPLOTW.EXE'//char(0)

         endif



      else

c        DPLOT IS running. Use API routines to get filespec.

         hInstDPLOT=GetWindowWord(hWndDPLOT,GWW_HINSTANCE)
         wStatus=GetModuleFileName(hInstDPLOT,szDPLOT,
     1                             len(szDPLOT))

      endif

      dwLength=index(szDPLOT,char(0))
      wStatus = WinExec(szDPLOT(1:dwLength-1)//' '//
     1                  szFileName,SW_SHOWNORMAL)
      if( wStatus .lt. 32 )
     1   wStatus=MessageBox(hWnd,'Cannot find DPLOTW.EXE'//char(0),
     2                      'MYAPPLICATION'//char(0),
     3                      MB_OK .or. MB_ICONEXCLAMATION )

Notes:
(1) Registration database. DPLOT's SETUP routine automatically changes the user's registration 

database to indicate the location of DPLOTW.EXE. DPLOTW.EXE also checks the entry in the 
registration database against its location every time it runs, and modifies the database entry if necessary. 
(This might be necessary if the user has moved DPLOTW.EXE since installing it using SETUP.EXE)

(2) DPLOTW.INI. DPLOT writes its own location to the [Files] section of DPLOTW.INI at the end 
of every session. DPLOTW.INI is located in the Windows directory.

(3) WinExec. DPLOTW.EXE takes a substantial amount of time to load the first time. However, if 
the user does not close DPLOT, subsequent calls to WinExec are relatively fast.



    Executing DPLOT commands from another application

You can send a command or series of commands to DPLOT from another application through a dynamic-
data exchange (DDE) conversation, or "channel."    For commercial applications, you should refer to the 
documentation for the application to determine the method for initiating a conversation with DPLOT and 
executing commands for another application. Following is a brief demonstration of how to send a 
command to DPLOT from three different environments.

Visual Basic 3.0
Control.LinkMode = 0
Control.LinkTopic = "DPLOTW|System"
Control.LinkMode = 2
Control.LinkExecute "[FileNew()]"
Control.LinkMode = 0
where Control is any label, picture box, or text box.

Microsoft Word macro
channel = DDEInitiate("DPLOTW", "System")
DDEExecute channel, "[FileNew()]"
DDETerminate channel

Microsoft Excel macro
Channel =INITIATE("DPLOTW","System")

=EXECUTE(Channel,"[FileNew()]")
=TERMINATE(Channel)

Following is a list of the commands supported by DPLOT. All commands must be enclosed by square 
brackets. There should be no spaces in the command string, other than those embedded in character 
string arguments or used to delineate numeric parameters. Character arguments are always enclosed by 
double-quotation marks. Command names are not case-sensitive.

About
Activate
AppHide
AppMaximize
AppMinimize
AppRestore
AppShow
AutoScale
AutoSize
AverageAll
BarChartStyle
BaselineShift
Caption
ClearEditFlag
Color
Compare
CopyPicture
CopyText
CurveFit
DataProcess
DenseGridLines
Differentiate
DocHide



DocMaximize
DocMinimize
DocRestore
DocShow
EditAddToX
EditAddToY
EditDecimate
EditEqualInts
EditErase
EditFilter
EditMultiplyX
EditMultiplyY
EditRemoveTrend
EditSmooth
EditSort
EditSwapXY
EditTruncate
FFT
FFTMethod
FFTPhase
FileAppend
FileArrays
FileClose
FileExit
FileNew
FileOpen
FilePageSetup
FilePrint
FileSaveAs
FileType
FillBetween
FontPoints
GridLines
HelpContents
HelpSearch
Histogram
InsertLink
Integrate
Legend
LegendParams
LineType
LineWidth
Lump
ManualScale
MultipleYAxes
NoteOptions
NotePosition
NoteTabstops
NoteText
NumberFormat
Paste
PostponeRedraw
Say
Scale
SelectCurve
SendKeys



SetBitmapDims
SetMetafileDims
ShowCaption
Size
SquareLogCycles
StartStop
SymbolSize
SymbolType
TextFont
TextNote
TextPointLabel
Title1
Title2
Title3
ViewRedraw
ViewStatusBar
ViewToolBar
WindowCascade
WindowTile
XAxisLabel
XY
YAxisLabel
Y2AxisLabel

Commands may be issued in sequence or appended to each other. For example, the following command 
string opens and prints a DPLOT file entitled "TEST.GRF" before causing DPLOT to close:

[FileOpen("TEST.GRF")][FilePrint()][FileExit()]

Notes
1) Each DDE conversation has an association with a DPLOT document. This association is 

established when the conversation is initiated, and may be changed by an Activate, FileOpen, or FileNew 
command.    If, for whatever reason, either DPLOT or the client application terminates the conversation 
and the client then establishes a new conversation, this association no longer holds. The client application
should re-establish the association with a document with the Activate command, else any commands sent
to DPLOT may not operate on the intended document.

2) Character string arguments are always enclosed by double quotation marks. In some 
environments (Visual Basic, for example), double quotation marks are also used to delineate character 
string arguments. The following example will always cause a syntax error in Visual Basic:

Control.LinkExecute "[FileOpen("myfile.grf")]"
Instead, use:
q$ = chr$(34)
Control.LinkExecute "[FileOpen(" & q$ & myfile.grf & q$ & ")]"
where 34 is the ASCII code for a double quotation mark.

3) For real time applications, it is strongly suggested that the client application use the 
ManualScale command to force the plot coordinates to the desired value. Otherwise, DPLOT will 
continually adjust the plot coordinates to fit the incoming data. If the ManualScale command is issued 
DPLOT keeps the extents of the X axis constant, shifting the plot window to the right when necessary.

4) For linear X, linear Y scales, DPLOT draws individual line segments rather than redrawing the 
entire plot every time a new data point is added with the XY command. DPLOT will only redraw the plot if 
the incoming data point lies outside the current plot extents. Although this optimization results in 



significantly faster plotting, there are several drawbacks: a) Since points are added one at a time rather 
than drawing a series of line segments, the pattern for a line style starts over at each point. Rather than 
using the slower line drawing routines that use a pattern (and would be incorrect anyway), DPLOT uses 
the faster Windows API routines MoveTo and LineTo with solid lines. b) DPLOT does not create and load 
the color palette selected by the user. Instead, the colors used to draw the line segments are the closest 
match of the system colors to the desired colors. Both of these limitations apply only to line segments that
are drawn individually. Once the entire plot is redrawn, the lines will be drawn correctly. 

5) DPLOT returns one of 3 values in response to any command. The return codes sent to the 
DDEML (Dynamic Data Exchange Management Library) are DDE_FACK, DDE_FBUSY, and 
DDE_FNOTPROCESSED. The various development environments respond to these return codes in 
different manners, usually by displaying a MessageBox in the case of DDE_FBUSY or 
DDE_FNOTPROCESSED. DDE_FACK indicates success. DDE_FBUSY indicates that DPLOT is 
currently disabled (possibly because a MessageBox or other modal dialog box is displayed). 
DDE_FNOTPROCESSED indicates that the command was not valid or was unsuccessful for some other 
reason (exceeding the array sizes, for example). Note that DPLOT does not cache incoming commands 
if it is currently busy... it is up to the client application to re-send the commands later, if necessary. Real 
time client applications should not rely on DPLOT to save incoming data values.

For optimum performance with real time applications
1) Use the ManualScale command.
2) Set all line widths to 0 with the LineWidth command.
3) Set all line styles to solid (type = 1) with the LineType command.

The example Visual Basic project VBDPLOT.MAK provides several examples of communicating with 
DPLOT through dynamic data exchange. The VBDPLOT application is located in the \VB subdirectory 
below DPLOT.

The Microsoft Word document template DPLOTW.DOT (distributed with DPLOT) contains a macro 
(DDEDPLOTOpenFiles) that demonstrates how to use the DDEExecute macro command.



    Creating and/or running a macro

A macro is a series of DPLOT commands that you can group together to automate certain tasks. Macros 
are especially useful in performing common operations on a group of files. The macro editing window is 
shown below:

The name of the macro currently displayed in the text box is shown at the top of the window.

The text box shows a series of macro commands. Macro commands may be preceded by one or more 
spaces or tabs. (To enter a tab in the text box, press CTRL+TAB). Each line may contain only one macro 
command.

Comment lines
Comments may be included in a macro by preceding the text with an apostrophe. DPLOT ignores 
comments when the macro is run. If the first non-space, non-tab character in a line is an apostrophe, or if 
the first 3 characters are "REM", the entire line is ignored. End-of-line comments are allowed using a 
leading apostrophe. Blank lines or lines consisting entirely of spaces and/or tabs are ignored.

Toolbar

Select the Run button to send the macro commands to DPLOT.



Select the Step button to single-step through a macro, pausing after each command is 
processed. This feature might be useful for debugging a macro.

Select the Stop button to terminate macro processing. Note: Most macros are completed in such 
a short time that the Stop button will usually be ineffective unless you are single-stepping through a macro
with the Step button.

The Save button is used to save the contents of the macro to a file, and to update the contents of 
DPLOTW.INI, so that DPLOT will be aware of the location and filename for the macro. Filenames are 
automatically generated by the macro editor, and the macro files are placed in the \MACROS subdirectory
below the DPLOT directory.

It is not necessary to save a macro in order to run it from the Macro editor. However, if you want 
to use the macro in the future, you must save it.

If you make changes to a macro, the editor will prompt you to save it before opening a new macro
or exiting the macro editor.

Select the Print button to print the contents of the text box to the default printer (set with Control 
Panel).

Select the Cut button to remove selected text and put it on the Clipboard.

Select the Copy button to copy the selected text to the Clipboard.

The Paste button inserts a copy of the Clipboard contents at the insertion point, replacing the 
selection (if any) with the text on the Clipboard

Select the Find button to search the text box for a word or phrase.

Select the Help button to display Help for the macro command found at the insertion point. If the 
insertion point is not at a macro command, selecting the Help button (or pressing F1) brings up this Help 
topic.

The Shortcut list box allows you to select a keystroke combination which will automatically run the macro 
from within DPLOT. Before saving the macro, the editor checks the selected shortcut against any existing 
shortcuts for other macros, and displays an error message if a conflict exists.

To copy all or a portion of one macro to another:
· Select the text of the source macro, either by pressing the Shift key in combination with the arrow 

keys, or by dragging the mouse over the text you want to copy.
· Press Ctrl+C or click on the Copy button.
· If you are using DPLOT for Windows 3.1, close the Macro Editor.
· Switch to DPLOT and select the Macro command from the File menu. Enter a name for a new 

macro or select an existing macro to edit.
· Click on the Edit/Create button, launching the Macro Editor.
· In the Macro Editor window, move the cursor to the desired location, then press Ctrl+V or click on 

the Paste button.

The mechanism used to run macro commands is very similar in function to the methods outlined in 
"Executing DPLOT commands from another application". Both methods use Dynamic Data Exchange 
(DDE) to send commands to DPLOT. Macros have the following advantages over the "another 
application" method:

· Macros do not require the user to possess a programming language that supports DDE (such as 
Visual Basic) or a third party application that allows DDE commands (e.g. Microsoft Word or 
Microsoft Excel).

· Macros can be activated by shortcut keys.
· Online Help is more readily available for macros.



However, the Visual Basic environment, as well as that of other DDE-aware applications, may provide you
with features that are not possible to implement in macros. For example, it is relatively easy to build a 
Visual Basic application which generates data points and to then send those data values to DPLOT.

For a list of all available macro commands, see DPLOT command syntax.

Note: The format of macros used by this version of DPLOT differs from that of versions prior to 1.1. You 
can convert old macros to the new format using the utility DPCONV.EXE, found in the \MACROS 
subdirectory below DPLOT.



    DPLOT command syntax

The following list of commands may be used either in macros or by sending the commands to DPLOT via 
dynamic-data exchange (DDE). Some commands are valid only in macros (noted by Macros Only). 
Commands sent to DPLOT via DDE must be enclosed by square brackets [          ]. Macro commands 
should NOT include the brackets.

[About()]
Displays the About dialog box for DPLOT.

[Activate("caption")]
Activates the document with the character string caption in the title bar. Subsequent commands 
reference this document.

[AppHide()]
Hides the DPLOT application window.

[AppMaximize()]
Maximizes and activates the DPLOT application window.

[AppMinimize()]
Minimizes (reduces to an icon) the DPLOT application window.

[AppRestore()]
Restores (to unmaximized or unminimized size) the DPLOT application window.

[AppShow()]
Shows (after hiding) the DPLOT application window.

[AutoScale()]
Equivalent to the Automatic Plot Scaling command on the Options menu.

[AutoSize()]
Equivalent to the Automatic Size command on the Options menu. Also equivalent to the Size 
command with state=0.

[AverageAll()]
Creates a new curve consisting of the average amplitude of all curves in a document

[BarChartStyle(style)]
Sets style of bar charts to hollow (style=0) or filled (style=1)

[BaselineShift(time,value,start,stop)]
In data processing mode, modifies the primary record (pressure in a pressure-time history, 
acceleration in an acceleration-time history) so that the first integrated record (impulse or velocity, 
respectively) has an amplitude of value at time. Only shifts values of the primary record falling 
between the start and stop times. If start is a large negative number (< 1.E+19), the shift is applied 
to all amplitudes (the stop time is ignored). For more information see the description of the Baseline 
Shift menu command.

Call macro Macros Only
Launches another instance of the macro editor and runs the specified macro. Control is not returned 
to the caller until the called macro has completed.

[Caption("caption")]
Sets the caption for the document referenced by the current DDE conversation or macro.

[ClearEditFlag()]
Clears an internal flag that indicates whether the document has been edited, so that, when closing the
document, DPLOT does not prompt you to save the document. Any subsequent changes to the 
document will reset the flag.



[Color(index,r,g,b)]
Sets the entry in the color palette with index to the color with red, green, and blue components r,g,b, 
where r,g, and b range from 0 to 255. The color palette maintained by DPLOT contains 16 color 
specifications. If there are more than 16 curves, the color table is recycled (curve #17 uses color #1, 
curve #18 uses color #2, etc.) If index = -1, then r,g,b are used for all 16 palette entries. For example,
[Color(3,255,0,255)]
sets the color for the third (and 19th) curve to magenta, and
[Color(-1,0,0,0)]
sets the color for all curves to black.

[Compare(Curve1,Curve2)]
Generates a new curve with amplitudes equal to the amplitudes of Curve1 minus the amplitudes of 
Curve 2.

[CopyPicture()]
Copies metafile and bitmap representations of the document, as well as the current color palette, to 
the Windows clipboard.

[CopyText()]
Copies the data values for the curve selected with the SelectCurve command to the Windows 
clipboard as text, one data pair per line. X and Y values are separated by [TAB] characters.

[CurveFit(order)]
Uses least-squares curve fitting procedures to find the order'th order polynomial that best fits the 
data values for the curve selected with the SelectCurve command. If successful, the CurveFit 
command generates a new curve using the fitting polynomial. The new curve will have the maximum 
number of points (set by the FileArrays command), equally spaced between the limits of the input 
curve.. For more information, see the Help topic on the Curve Fit menu command.

[DataProcess(state,"datatype",format)]
Turns data processing mode on (state=1) or off (state=0). If state=1, datatype is a descriptive term 
for the data from the table below. Datatype must include enough characters to uniquely identify the 
type of data. For example, datatype for stress or strain measurements must include at least four 
characters. Format is 1 for wide plots, square format is used otherwise. Datatype and format may be
omitted for state=0. For more information, see the Help topic on the Data Processing menu 
command.

Data Types
Acceleration
Deflection
Pressure
Strain
Stress
Temperature

NOTE: If data processing mode is turned on, new documents will be opened in data processing 
mode. This may not always be appropriate. Applications for DPLOT written by other developers 
should always turn data processing mode off after closing all documents.

[DenseGridLines(state)]
Turns on (state=1) or off (state=0) dense grid lines. For more information see the Grid Lines or Box 
menu command.

[Differentiate()]
Differentiates (finds ¶y/¶x) the curve or curves selected with the SelectCurve command. If the 
ordinate of the curve is evenly spaced, quadratic interpolation is used to find the derivative at each 
point. Otherwise an inverse of the trapezoidal rule is used. For more information see the Differentiate 



menu command.

Directory("dir")] Macros Only
Sets the directory for all subsequent FileOpen and FileSaveAs operations. If the filenames used in a 
FileOpen or FileSaveAs command contain a path specification, this specification overrides the path 
specified by the Directory command.

[DocHide()]
Hides the document window referenced by the DDE conversation or macro.

[DocMaximize()]
Maximizes and activates the document window referenced by the DDE conversation or macro.

[DocMinimize()]
Minimizes (reduces to an icon) the document window referenced by the DDE conversation or macro.

[DocRestore()]
Restores (to unmaximized or unminimized size) the document window referenced by the DDE 
conversation or macro.

[DocShow()]
Shows (after hiding) the document window referenced by the DDE conversation or macro.

[EditAddToX(value)]
Adds value to X. Operates on the curve or curves selected with the SelectCurve command.

[EditAddToY(value)]
Adds value to Y. Operates on the curve or curves selected with the SelectCurve command.

[EditDecimate(method,replace,value,start,stop)]
Decimates data values in the curve or curves selected with the SelectCurve command. Method = 0 to
average every value points, = 1 to discard all but every value'th point, or = 2 to use the Welch 
depopulation scheme with fidelity = value. Replace = 1 to replace existing data points, = 0 to 
preserve the original data and produce a new curve. Operates on data points between X = start and 
X = stop. To operate on all points in a curve, specify start, stop values less than and greater than the
extents of the data, respectively.

[EditEqualInts(replace,interval,method)]
Generates a new curve with a constant spacing of interval on the abscissa (X axis), using linear 
(method = 1), quadratic (method = 2), cubic (method = 3), or cubic spline (method = 4) 
interpolation. Replaces the existing curve if replace is not equal to 0, otherwise generates a new 
curve. Operates on the curve or curves selected with the SelectCurve command. For more 
information see the description of the Equal Intervals command.

[EditErase()]
Deletes the curve most recently selected with the SelectCurve command. After the succesful 
completion of this command the curve selection becomes undefined.

[EditFilter("user",twopasses,replace,C0,C1,C2,D1,D2)] or
[EditFilter("bandpass",twopasses,replace,frequency,bandwidth,timeunits)] or
[EditFilter("optionX",twopasses,replace)]

Applies a digital filter to the curve most recently selected with the SelectCurve command.

USER filter: C0, C1, C2, D1, and D2 are the coefficients of the filter equation to be used (described in 
the Filter topic). 

BANDPASS filter: frequency is the frequency to remove from the data record. If frequency is equal 
to 0, the zero frequency rejection filter is used and bandwidth and timeunits are ignored. If 
bandwidth is less than or equal to 0 (or omitted), DPLOT uses the Carleton method. Otherwise, the 
Press method is used.

OPTIONX filter: X must be one of 1, 2, 3, or 4 and corresponds to the filters described in the Filter 
topic.



If twopasses is non-zero, then the filter is applied twice, the second time in time-reversed order in an 
attempt to remove any phase shift induced by the operation. If replace is non-zero, then the original 
data set is replaced by the filtered data. If replace is equal to 0, then the original data is preserved.

[EditMultiplyX(value)]
Multiplys X by value. Operates on the curve or curves selected with the SelectCurve command.

[EditMultiplyY(value)]
Multiplys Y by value. Operates on the curve or curves selected with the SelectCurve command.

[EditRemoveTrend()]
Removes any linear trend from the curve or curves selected with the SelectCurve command, so that 
the first and last amplitudes are equal to 0.

[EditSmooth(replace,window)]
Smooths the amplitudes of the curve or curves selected with the SelectCurve command. The 
smoothing window is the number of points over which the data should be smoothed. Zero gives no 
smoothing at all, while a value approaching half the number of data points will render the data virtually
featureless. The existing curve will be replaced by the new curve if replace = 1, otherwise the existing
curve will be preserved. For more information see the Help topic on the Smooth command.

[EditSort()]
Sorts the data for the curve or curves selected with the SelectCurve command in ascending abscissa 
(X) order.

[EditSwapXY()]
Exchanges the X and Y values for the curve or curves selected with the SelectCurve command.

[EditTruncate(from,to)]
Eliminates all data outside the range specified by from < X < to. Operates on the curve or curves 
selected with the SelectCurve command.

[FFT()]
Performs a Fast Fourier Transform on the curve selected with the SelectCurve command. The FFT 
command creates a new document window for displaying the output. For more information, see the 
Help topic for the FFT menu command.

[FFTMethod(method)]
If method is equal to 0, DPLOT pads the input record with zeroes out to the next highest power of 2 
so that a more efficient FFT algorithm can be used. If method is not equal to 0, DPLOT does not 
modify the input record. Using method ¹ 0 may result in very long run times, depending on the 
number of points in the input record. For more information, see the Help topic for the FFT menu 
command.

[FFTPhase(state)]
If state ¹ 0, DPLOT generates a phase angle plot along with the FFT amplitudes.

[FileAppend("filename")]
Opens a file, creating one or more new curves in the currently active document. The file type must 
not be a DPLOT file. The FileType command should be issued before the FileAppend command.

[FileArrays(maxc,maxp)]
Sets the maximum number of curves and the maximum number of points per curve. DPLOT will not 
plot more points than maxp per curve or create more curves than maxc.

[FileClose()]
Closes the document referenced by the current DDE conversation or macro. It is not possible to 
predict which document will be associated with the DDE conversation or macro after a FileClose 
command. If any subsequent commands are to be executed, they should be preceded by an 
Activate, FileNew, or FileOpen command.

[FileExit()]
Closes DPLOT. Developers should use care in issuing this command, since it is possible that the user



may have opened DPLOT for another purpose before this transaction took place.

[FileMacro()]
Displays the macro dialog box.

[FileNew()]
Finds an empty document window. If no empty document window exists, FileNew opens a new 
document window. Subsequent commands in the same DDE conversation or macro reference the 
newly opened document.

[FileOpen("filename")]
Opens and displays a file in a new or empty document window. If the file type is not a DPLOT file, 
then the FileType command should be issued before the FileOpen command. Subsequent 
commands reference the document created by this command.

[FilePageSetup(top,bottom,left,right)]
Sets the printer margins (in inches) for the currently selected document.

[FilePrint()]
Prints the document using the current default printer settings.

[FileSaveAs(type,"filename")]
Saves the document to filename as:

type Format
1 DPLOT file
2 ASCII data, selected curve only
5 Unformatted data, selected curve only
4096 Windows metafile

For more information on the file types see the description of the Save As menu command.

Macros Only
If placed in a ForFilesIn... NextFile loop, then only a filename extension, preceded by a dot, is used. 
The filename used to save the document will be identical to the original filename but with the 
extension specified. If omitted, an extension dependent on the type code is automatically selected:

type Extension
1 .GRF
2 .ASC
5 .BIN
4096 .WMF

Example:
ForFilesIn("ex*.grf")

FileSaveAs(4096,"")
FileSaveAs(1,".new")
FileClose()

NextFile
Saves all of the files matching the specification "ex*.grf" as Windows metafiles with the filename 
extension ".wmf", and as DPLOT files with the extension ".new".

[FileType(n)]
Sets the file type code prior to opening a document with the FileOpen command. n is one of:

1 DPLOT file 
2 ASCII file, one data set with arbitrarily spaced points.
3 ASCII file, one data set with evenly spaced points.
4 ASCII file, fixed width columns with multiple Y values for each X.
5 Unformatted data.
6 Binary file produced by Pacific Data Model 9820 recorders, DNA/Bendix 

format.
7 Binary file produced by Pacific Data recorders, WES/ISD OLD format.
8 Binary file produced by Pacific Data recorders, WES/ISD NEW format.



9 Nicolet Time Domain files (binary) created with the Nicolet System 400 Digital 
Oscilloscope.

10 Hardened Data Acquisition System (HDAS) files.
For more information on file types, see the description of the Open menu command.

[FillBetween(Curve1,Curve2,Style,R,G,B)]
Fills the area between Curve1 and Curve2 with a hatch pattern of Style and color R,G,B. Valid 
values for Style are:

-1 Solid
0 Horizontal lines
1 Vertical lines
2 45 degree downward
3 45 degree upward
4 Horizontal-vertical crosshatch
           
5

45 degree crosshatch

[FontPoints(index,points)]
Sets the size of the indexed font to points. Font indices used by DPLOT are:

1 Numbers along the axes
2 First title line
3 Second and third title lines
4 X axis label
5 Y axis label(s)
6 Legend and/or note

For more control over the fonts, see the TextFont command

ForFilesIn("filespec") Macros Only
Allows you to loop through one or more operations on several files matching a given file specification. 
"ForFilesIn" commands must have a matching "NextFile" command, which terminates the loop. 
"ForFilesIn...NextFIle" loops may not be nested. The following example opens each of the files in the 
current directory matching the file specification ex*.grf, prints the file, and closes it before operating on
the next file matching that specification.

ForFilesIn("ex*.grf")
FilePrint()
FileClose()

NextFile
Alternatively, the ForFilesIn command can read a list of filenames from a text file by placing an "@" 
symbol before the file specification. For example,

ForFilesIn("@file.lst")
FilePrint()
FileClose()

NextFile
reads a list of filenames from the file FILE.LST, prints and closes each file.

Generate("formula",XStart,XEnd,dX) Macros Only
Generates X,Y pairs between X = Xstart and X=XEnd with interval dX using the formula. This 
command requires the presence of Microsoft Excel version 5.0 or later on your system. Formula 
should be a function of X, and can be any valid Excel formula (an equal sign is optional). In the 
following example, DPLOT plots the sine of X from 0. to 10. at an interval of 0.1:
Generate("sin(x)",0.0,10.0,0.1)
Conditionals are allowed in formulas and have the general syntax:
IF(test,iftrue,iffalse)
For example,



Generate("IF(x<5,x^2,25-(10-x)^2)",0.0,10.0,0.1)
plots Y=X^2 from 0 to 5 and Y=25-(10-x)^2 from 5.1 to 10.

Consult the Microsoft Excel documentation for more information on correct formula syntax. In 
particular, the Math and Trigonometic Functions Help topic might be useful.

[GridLines(style)]
Controls the appearance of the X and Y axes. Style=0 for axes only, =1 for a box around the plot with 
horizontal and vertical grid lines at each tick mark, =2 for a box around the plot with no grid lines.

[HelpContents()]
Starts Windows Help and displays the Contents topic

[HelpSearch("string")]
Starts Windows Help and displays the topic found in the keyword list that matches the keyword 
string. If there is no match, displays the Search dialog box.

[Histogram(interval)]
Plots the frequency distribution of the amplitudes of the curve selected with the SelectCurve 
command. The sampling interval is specified by interval. This command generates a new document. 
For more information see the Help topic on the Histogram command.

Macro Example
Histogram(100)
Activate("Histogram")
BarChartStyle(1)

[InsertLink("Application","Topic","Item")]
Inserts an active link from a DDE server into the current document. For more information see the 
Insert Link menu command.

[Integrate()]
Integrates the curve or curves selected with the SelectCurve command. For more information see the 
Help topic on the Integrate menu command.

[Legend(curve,"string")]
Sets the legend for curve number curve to the character string string.

[LegendParams(linelength,maxrows,frame,opaque,x,y)]
Sets various parameters for the legend. linelength is the length of the line segment (in inches) 
appearing beside each legend string. maxrows is the maximum number of legend strings to place in 
one column. frame = 1 to draw a rectangle around the legend, = 0 for no frame. opaque =1 to hide all
objects intersecting the legend. x,y is the location of the upper left corner of the legend, expressed as 
a percentage of the plot window size (0.0 to 1.0).

[LineType(curve,type)]
Sets the line style for curve number curve to type, where type may be 0 (no lines) through 6.

[LineWidth(curve,width)]
Sets the width of the line segments used to draw curve number curve to width 1000'ths of an inch.

[Lump(Curve1,Curve2)]
Creates a new curve whose amplitudes are the sum of the amplitudes for Curve1 and Curve2.

[ManualScale(xlo,ylo,xhi,yhi)]
Forces the coordinates of the lower left and upper right corners of the plot. By default, DPLOT 
automatically scales the plot. Recommended for real time applications.

[MultipleYAxes(type,A,B)]
Controls the appearance of the Y axis.

type Description



0 Single Y axis
Constants A and B are ignored.

1 Y2=f(Y1)
A second Y axis is linked to the primary Y axis by the function Y2 = A + B*Y1.

2 Independent Y2
A second Y axis is independent of the primary Y axis. Constant A = 1 to 
associate the selected curve with the left axis, = 2 to associate the selected 
curve with the right axis. Curve 1 must be associated with the left axis. 
Constant B is ignored.

For more information, see the Help topic on the Multiple Y Axes menu command.

[NoteOptions(flags)]
Changes the appearance of a notation. Flags is a combination of:

2 Draw a rectangular frame around the notation.
4 The notation is opaque; objects intersecting the notation will be hidden from 

view.
8 The notation is activated by a button.

[NotePosition(x,y)]
Controls the position of the notation on the plot. X,Y are the coordinates of the upper left corner of the
note, expressed as a percentage of the plot size (0.0 to 1.0).

[NoteTabstops(tab)]
Tab is the number of character cells used for tab positioning in a notation.

[NoteText("text")]
Specifies the text that is displayed in a notation.

[NumberFormat(axis,style)]
Sets the style used to represent numbers along the X axis (axis=0) or Y axis (axis=1). Valid values 
for style are:

0 default
1 Scientific notation
2 Fractions
3 Dollars and Cents
4 Dollars

[Paste()]
Pastes the contents of the Clipboard to the active document. The format of the Clipboard contents 
must match that described under the Paste command (Edit menu) topic.

Pause Macros Only
Pauses the macro and displays a MessageBox allowing you to continue or abort the macro. This 
macro command is useful for testing purposes.

[PostponeRedraw()]
Delays redrawing any changes made to the document. This command may be useful when making 
many minor changes to a plot that would ordinarily cause the plot to be redrawn. The document will 
be redrawn after issuing a ViewRedraw command, or after issuing any command that causes the 
conversation to reference a different document (FileOpen, for example).

NextFile Macros Only
Terminates a ForFilesIn...NextFile loop.

[Say("message")]
Echos message to a sound card if the system is equipped with Monologue for Windows.

[Scale(code)]



Sets the scaling code for the plot (linear, logarithmic, etc.). The low byte of code should be one of the 
following:

1 Linear X, Linear Y
2 Linear X , Logarithmic Y
3 Logarithmic X, Linear Y
4 Logarithmic X, Logarithmic Y
5 Tripartite (log-log) scale
6 Linear X - Probability Y
7 Grain Size Distribution
8 Polar coordinates
9 Bar chart

Several scale types allow you to specify a unit system by adding an identifier to the scaling code. See
Scaling Code. for more information.

[SelectCurve(n)]
Selects the curve to perform subsequent operations on. Default = 1. If curve n does not currently 
exist, DPLOT creates a new curve. If n exceeds the maximum number of curves (set with FileArrays) 
DPLOT attempts to resize the arrays to accommodate a new curve. If n is set to -1, then any 
subsequent command that operates on one or more curves will operate on all curves.

[SendKeys("keys")]
Sends the keystrokes specified by keys to DPLOT, just as if they were typed at the keyboard.

Keys is a key or key sequence, such as "a" for the letter a, or "{enter}{pgup}" for the ENTER key 
followed by the PAGE UP key.

Note
Use SendKeys to operate DPLOT only when there is no alternative, and then use it with caution. In 
general, the other commands described in this topic provide a better way for other applications to 
interact with DPLOT because they provide a channel for two-way communication between 
applications and provide a path for detecting and dealing with errors in DPLOT. You should test even 
the simplest use of SendKeys under a variety of conditions to avoid unpredictable results, data loss, 
or both.

To specify keys that do not insert a character, use the following codes.

Key Code
BACKSPACE {backspace} or {bs} or 

{bksp}
BREAK {break}
CAPS LOCK {capslock}
CLEAR {clear}
DEL {delete} or {del}
DOWN ARROW {down}
END {end}
ENTER {enter} or ~
ESC {escape} or {esc}
HELP {help}
HOME {home}
INS {insert}
LEFT ARROW {left}
NUM LOCK {numlock}
PAGE DOWN {pgdn}
PAGE UP {pgup}
PRINT SCREEN {prtsc}
RIGHT ARROW {right}
TAB {tab}



UP ARROW {up}
F1, F2, F3,...F16 {F1}, {F2}, {F3},...

{F16}

Note
To repeat a character, use the syntax {Character Number}. For example, [SendKeys("{s 10}")] 
repeats the letter s 10 times. Remember to put a space between the key and the number. To repeat a 
key whose code already includes braces, add a space and a number within the braces, for example: 
[SendKeys ("{enter 10}")].

To send a key combination that includes SHIFT, ALT, or CTRL, use the following symbols.

To combine with Precede the key code by
SHIFT + (plus sign)
ALT % (percent sign)
CTRL ^ (caret)

For example, "%{enter}" sends the code for ALT+ENTER. You cannot emulate DPLOT's accelerator 
keys (^C for Copy Picture, for example) with the SendKeys command.

To send a plus sign (+), a percent sign (%), or a caret (^) as literal text, enclose the character in 
braces. For example, to send a plus sign, use the instruction [SendKeys("{+}")]. You can also use 
braces to send parentheses.

[SetBitmapDims(wPixels,hPixels)]
Sets the size of bitmaps copied to the Clipboard by the Copy Picture command.

[SetMetafileDims(wInches,hInches)]
Sets the size of metafile pictures copied to the Clipboard by the Copy Picture command.

Shell(command,nShowState)] Macros Only
Executes another program. Command  is the name of the program to execute along with any 
required arguments or command line switches. If the filename extension is omitted, ".EXE" is 
assumed. nShowState corresponds to the style of the window in which the program is to be 
executed. If omitted, defaults to 1.

The following table identifies the values for nShowState and the resulting style of window:
Value Window style
1 Normal with focus.
2 Minimized with focus.
3 Maximized with focus.
4 Normal without focus.
6 Minimized without focus.

Note:    Macro processing continues as soon as the Shell function returns. You cannot depend on a 
program started with Shell to be finished executing before the macro commands following the Shell 
function in your macro are executed.

[ShowCaption(state)]
Turns on (state=1) or off (state=0) the feature of drawing the document caption in the lower right 
corner of the window or page.

[Size(state,X,Y,WYSIWYG)]
For state = 0, DPLOT automatically calculates the size of a plot such that it fills as much of the 
document window as possible; X,Y, and WYSIWYG are ignored. For state ¹ 0, X and Y specify the 
physical size of the plot axes, in inches. If WYSIWYG ¹ 0, then DPLOT adjusts the font sizes used in 
the plot so that the displayed plot is identical (as close as possible) to a printed copy.

[SquareLogCycles(state)]



Forces the physical distance between log cycles to be the same on the X and Y axes for state=1.

[StartStop(start,stop)]
Sets the start and stop times for binary files. The StartStop command should be issued before a 
FileOpen command on a binary file.

[SymbolSize(curve,size)]
Sets the height of the symbols used for curve number curve to size 1000'ths of an inch.

[SymbolType(curve,type)]
Sets the symbol type, where type may be 0 (no symbols) through 12.

[TextFont(Index,Points,Weight,Italic,R,G,B,"Face")]
Sets various parameters for one of the six fonts used by DPLOT. Index should be one of the 
following:

1 Numbers along the axes
2 First title line
3 Second and third title lines
4 X axis label
5 Y axis label(s)
6 Legend and/or note

Points is the size of the font, where 1 point = 1/72 inch. Weight is a number between 100 for "thin" 
and 900 for "heavy" or 0 for "don't care", in which case Windows picks the font weight. Normal text 
has a weight of 400, bold text has a weight of 700. Not all font weights are available for all possible 
fonts... Windows selects the closest weight available. Italic is 1 for italics, 0 otherwise. R,G,B are the 
red, green, and blue components used in the font color, ranging from 0 to 255 (R,G,B = 0,0,0 
corresponds to black). "Face" is the font's face name,e.g. "Arial" or "Times New Roman".

[TextNote("Note",X,Y,Frame,Opaque,Button,TabStops)]
Adds a notation to the plot. Note is the text of the notation. X,Y are the coordinates of the upper left 
corner of the note, expressed as a percentage of the plot size (0.0 to 1.0). Frame = 1 to draw a 
rectangle around the note. Opaque = 1 to hide any objects intersecting the note. Button = 1 if the 
note is "activated" with a button. TabStops is the number of character cells used for tab positioning. 
See the Add/Edit Note command for more information.

[TextPointLabel(Point,X,Y,Frame,Opaque,"Label")]
Attaches a label to a specific data point. The label is attached to the point'th data point in the curve 
most recently selected with the SelectCurve command. X,Y are the coordinates of the label in data 
space. Frame = 1 to draw a rectangle around the label. Opaque = 1 to hide any objects intersecting 
the label. See the Help topic on the Label Points command for more information.

[Title1("string")]
Sets the first title line to string.

[Title2("string")]
Sets the second title line to string.

[Title3("string")]
Sets the third title line to string.

[ViewRedraw()]
Forces DPLOT to redraw the plot. For real time applications, DPLOT performs several optimizations 
that may leave undesirable artifacts on a plot. For example, line segments may intersect the legend 
and/or other plot features that were intended to be opaque. ViewRedraw causes DPLOT to draw the 
plot correctly. 

[ViewStatusBar(visibility)]
Shows (visibility=1) or hides (visibility=0) the status bar.

[ViewToolBar(visibility,largebuttons)]



Shows (visibility=1) or hides (visibility=0) the toolbar, with 24x22 pixel (largebuttons=0) or 32x30 
pixel (largebuttons=1) buttons.

[WindowCascade()]
Overlaps all DPLOT document windows, with the active document on top. Equivalent to the Cascade 
command on the Window menu.

[WindowTile()]
Displays all DPLOT documents in windows that do not overlap. Equivalent to the Tile command on 
the Window menu.

[XAxisLabel("string")]
Sets the X axis label to string.

[XY(x,y)]
Adds a data point to the curve selected with the SelectCurve command. If this operation would cause 
the number of points in the curve to exceed the array sizes, DPLOT returns 
DDE_FNOTPROCESSED to a DDE client, or causes an error in the DPLOT macro facility.

[YAxisLabel("string")]
Sets the Y axis label to string.

[Y2AxisLabel("string")]
Sets the Y axis label for a second Y axis label to string. The label is not displayed unless one of the 
Multiple Y Axes options is in effect.



    Using DDEML to send data directly to DPLOT

Applications may also send data directly to DPLOT (rather than writing to a file) through DDEML. A 
discussion of those procedures is beyond the scope of this documentation. Developers interested in 
this subject should contact the author at 601/634-3668.



    Getting a bitmap of the currently active DPLOT document

Applications can retrieve a handle to a bitmap of the currently active DPLOT child window using the 
following instructions (in FORTRAN):

      hWndDPLOT = FindWindow('DPLOT/W'c, NULL_POINTER )
      if( hWndDPLOT .ne. NULL ) then
         iMsg = RegisterWindowMessage('Get Bitmap'c)
         dwStatus = SendMessage(hWndDPLOT,iMsg,0,0)
         if( dwStatus .ne. 0 ) then
            hDC = GetDC(hWnd)
            call DrawBitmap(hDC,pt.x,pt.y,LOWORD(dwStatus))
            wStatus = ReleaseDC(hWnd,hDC)
         endif
      else
         call MessageBeep(-1)
      endif

The handle to the bitmap is returned in the low word of the return value for SendMessage.

In the example above, DrawBitmap is an application-defined routine that places the bitmap on the client 
area of the application's window.

Please note that the calling application (not DPLOT) is responsible for deleting the bitmap. 



        Transferring DPLOT plots to other applications

There are currently three methods for transferring DPLOT output to other applications. Each method has 
advantages and disadvantages.

Copy a bitmap image to the Clipboard.

As with any Windows application, you can copy the contents of DPLOT's window to the Clipboard by 
pressing ALT+PRINT SCREEN (press and hold the <Alt> key, then press the <Print Screen> key). On 
some keyboards, you may need to use ALT+GRAY* instead. This results in a bitmap image being placed 
on the Clipboard. Bitmap images may be pasted into several popular graphics editing programs and word 
processors. 

There are several disadvantage to using this method:

· The resolution is limited to the resolution of your display.

· Information content is lost, since a bitmap is only a digitized version of the plot.

· A bitmap image of DPLOT's entire window, including title bar, menu, and status bar (if present) will be 
saved to the Clipboard.

For best results, maximize DPLOT's window and turn off the status bar before copying the window to the 
Clipboard.

Copy a metafile to the Clipboard.

Select the Copy Picture command (or press CTRL+C) to copy a metafile to the Clipboard. A metafile 
preserves all of the information content of a plot and is much easier to edit than a bitmap. A metafile is 
device-independent, so the resolution of the image will be that of the final destination output device.

However,    a much more limited number of applications can support metafiles than bitmaps, and in some 
cases the metafile will be automatically converted to a bitmap.

The Copy command also creates a bitmap image and transfers that image to the Clipboard. The bitmap 
created by the Copy command will not include the windows title bar, menu, or status bar, but the 
limitations concerning resolution and scalability mentioned above still apply. The bitmap image created by
the Copy command has a fixed size of 640x480 pixels.

Create a Hewlett Packard Graphics Language (HPGL) file.

Before running DPLOT, you should make sure that you have an HP Plotter installed as a printer. If not, 
select Printers from Control Panel and Add an HP Plotter. When printing a DPLOT file, select Setup 
from the "Print" dialog box, and select the HP Plotter as the output device. Select "Print to file" to create 
an HPGL file. Many word processing applications will import an HPGL file.

At this writing, the HP Plotter driver lacks some of the features of other device drivers. In particular, the 
plotter driver will not clip around the legend properly.

DPLOT will automatically select the plotter "Stroke" font for all text when printing to a plotter, regardless of
font selections that you make.



        Transferring DPLOT data to other applications

There are currently two methods for transferring DPLOT data to other applications.

Copy data to the Clipboard.
You can copy the data values of a single curve to the Clipboard, then paste the data in the target 
application. See Copy Data Values command.

Use target application's DDE features.
If the target application can serve as a Dynamic Data Exchange (DDE) client, you can instruct DPLOT to 
provide application information and/or data for one or more curves. The following Microsoft Excel 
formulas may be used to request information from DPLOT:

Formula Returns
=DPLOTW|System!Topics XYPlot

System
Plot title(s), if any

=DPLOTW|System!SysItems Topics
or SysItems
=DPLOTW!System!TopicItemList Formats

Status
TopicItemList
Help

=DPLOTW|System!Formats TEXT
=DPLOTW|System!Status Ready or Busy
=DPLOTW|System!Help See DPLOTW Help... "Transferring DPLOT data to other

applications"

For formulas that return more than one value, you must first select the desired cells in the worksheet, 
enter the formula, then press <Ctrl>+<Shift>+<Enter>.

In addition, if one or more plots are currently open, you can use the target application's DDE features to 
request information about those plots. For example, if there is a plot entitled SQUARES.GRF in DPLOT, 
then the following Excel formulas can be used to request information about that plot:

Formula Returns
=DPLOTW|SQUARES.GRF!TopicItemList Formats

NumberOfCurves
NumberOfPoints
TopicItemList
Curve01

=DPLOTW|SQUARES.GRF!Formats TEXT
=DPLOTW|SQUARES.GRF!
NumberOfCurves

1

=DPLOTW|SQUARES.GRF!
NumberOfPoints

4

=DPLOTW|SQUARES.GRF!Curve01 1 1
2 4
3 9
4 16

The plot title is the text that appears in the caption of the plot window. This string may be "Untitled". If 
more than one plot has the same title, DPLOT returns information on the first one created.



Data values submitted by DPLOT are separated by <TAB> characters. A <CR><LF> sequence separates 
X,Y pairs.



    Getting Help within DPLOT

Context-sensitive help is available for most DPLOT menu commands and selected regions of the screen. 
Following is a description of the help-related keys:

Key(s) Function

F1 Gets Help and displays the Help Index for DPLOT. If the Help window is already open 
and active, pressing F1 displays the "How to Use Help" topics.

Pressing F1 while a menu command is highlighted displays a Help topic on the selected 
command.

SHIFT+F1 Changes the pointer to  so you can get Help on a specific command or screen region. 
You can then choose a command or click the screen region you want to know more 
about.

Escape Changes the pointer to the normal .
The Help button on the toolbar toggles context-sensitive help. Double-click the help button to 

display a Search dialog box to search for help on a specific topic.



    Prompt to save a plot

By default, DPLOT will prompt you before exiting to ask whether you want to save the current plot to a 
DPLOT file if the current plot has been edited in any way. You can defeat this default behavior by editing 
the DPLOTW.INI file, located in the Windows directory.

· Start Notepad or any ASCII text editor.
· Open DPLOTW.INI
· Look for the "SavePrompt" entry in the [FLAGS] section.
· To defeat the prompt, change the value to 0. To enable the prompt, set the value to 1.
· If the "SavePrompt" entry is not present, enter the line "SavePrompt=0" or "SavePrompt=1" under the 

[FLAGS] section.



    Toolbar description

The toolbar contains buttons that give you quick mouse access to many commands and features in 
DPLOT. For example, you can open a new document by clicking the New button on the toolbar.

New button

You can display or hide the toolbar by choosing Toolbar from the View menu. You may need to enlarge 
the DPLOT window to the full width of the screen to see the entire toolbar.

You can see a description of each toolbar button in the status bar. When you point to any button with the 
mouse, the button description will appear in the status bar. A short description of each toolbar button is 
also provided in a ToolTip. When you point to a button with the mouse, the button name will appear in a 
box just below the mouse cursor:

Click on any of the toolbar buttons below to see a detailed description of the corresponding command.

____________________________
See also:

Moving the toolbar



    Moving the Toolbar

You can move the toolbar from its default position at the top of the screen to any location on the screen to
better fit your working style and the layout of the document you are working on.

If you move the toolbar anywhere within DPLOT's application area, it becomes a floating toolbar.

To move and resize the toolbar
1. Position the mouse pointer in an empty area on the toolbar, and then drag the toolbar to the location 

you want.
2. Once you've moved the toolbar from the top of the screen, you can do any of the following:

To Do this
Move a floating 
toolbar

Point to the title bar on the 
toolbar, and then drag the 
toolbar to a new position.

Resize a floating 
toolbar

Point to any edge of the 
toolbar. When the mouse 
pointer becomes a two-
headed arrow, drag until the
toolbar is the size you want.

 Two-headed arrows

Return the toolbar
to its original 
position

Drag the title bar to the top 
of the screen.

Note
You can also create a floating toolbar by double-clicking an empty area on the toolbar, and you can return
a floating toolbar to the top of the screen by double-clicking its title bar.



    Dialog Box keys

TAB Moves to the next list box, text box, check box, command button, or group of 
option buttons.

SHIFT+TAB Moves to the previous list box, text box, check box, command button, or group of 
option buttons.

Arrow keys Move and select within the active list box or group of option buttons.

SPACEBAR Selects the active check box or chooses the active command button.

Letter key Moves to the next item beginning with that letter in an active list box.

ALT+Letter key Selects the item with that underlined letter.

ALT+Backspace Restores text in a text box to the original character string.

ENTER Chooses the default command button.

ESC Cancels the command and closes the dialog box.



Options Menu

Linear/Log Scaling
Change how the data is scaled to device.

Grid Lines or Box
Controls the appearance of the X and Y axes.

Symbol/Line Styles
Change the appearance of a curve.

Automatic Plot Scaling
DPLOT selects extents of the plot.

Manual Scaling
User selects extents of the plot.

Automatic Size
DPLOT selects the size of the plot and the number of tick mark intervals.

Set Physical Size
User selects the physical size of the plot and the number of tick mark intervals.

Square Log Cycles
Toggles state of the appearance of log cycles.

Multiple Axes
Presents several choices for scaling the X and Y axes.

Number Formats
Allows you to change the appearance of numbers.

Colors
Change color palettes used for drawing curves.

Fill Between Curves
Draws a hatched pattern or solid fill between two curves.

Data Processing
Automatically generate integrations and set plotting options.



Linear/Log Scaling (Options menu)

Currently available scaling options are:

· Linear X, Linear Y
· Linear X , Logarithmic Y
· Linear X - Probability Y
· Logarithmic X, Linear Y
· Logarithmic X, Logarithmic Y
· Logarithmic X, Probability Y
· Probability X, Linear Y
· Probability X, Logarithmic Y
· Probability X, Probability Y
· Tripartite (log-log) scale
· Grain Size Distribution
· Polar coordinates
· Bar chart

Tripartite grids
Tripartite grids are generally used to plot shock spectra for a given velocity record or fragility curves for 
shock-sensitive equipment. Click to see an example. By default, a tripartite grid is set up for a shock 
spectra plot with X values = Frequency in hertz, Y values = velocity in inches/sec, 45 degree lines = 
displacement in inches, and 135 degree lines = acceleration in g's. Units may be changed with the Units 
menu command.

The tripartite grid selection will override the grid type selection made with the Grid     Lines     or     Box.   
command.

Probability scale
Amplitudes for probability scales must be in the range 0 < y < 100. Values less than 0.01 or greater than 
99.99 are clipped. A Cumulative Distribution Function (CDF) for a normally distributed variable will plot as 
a straight line using "Linear X - Probability Y" scaling.

Grain size distribution
Amplitudes (percent finer values) for "Grain Size Distribution" scaling must be in the range 0 < y < 100, 
and the abscissa (grain sizes) must consist of positive values. Unlike all other scaling options, this option 
automatically fills in values for the X and Y axis labels, as well as a second Y axis label located on the 
right side of the plot. Click to see an example. These labels may be changed, however, with the Title/Axes
menu option.

By default, the grain size plot is set up for grain sizes in millimeters. A U.S. Standard Sieve scale will be 
drawn at the top edge of the plot, and a scale showing the range in size of common engineering materials
is drawn below the X axis. These features require that the units of the grain sizes be known. The units 
may be changed with the Units menu command.

Grain size distribution plots will generally have a better appearance if you force the abscissa (X) to range 
from 0.001 mm to 1000. mm (or 0.00001 to 100. inches) using the Manual     Scaling   menu option.

The grid type selection made with Grid     Lines     or     Box   is ignored.

Polar coordinates
Both the abscissa (angle) and ordinate (radius) must be greater than or equal to 0.

By default, angles are assumed to be in radians. Angular units may be changed to degrees with the Units 
menu command. Angles are displayed in degrees regardless of which unit type is in effect.

Several menu options are disabled when viewing data with polar coordinates. In particular, you cannot 



use the Zoom command or the Manual Scaling command. In addition, the X and Y axis labels are not 
used (and so may not be edited) in polar plots.

The grid type selection made with Grid     Lines     or     Box   is ignored.

Bar chart
The abscissa must have a constant spacing for bar charts. X values are used as the lower limit of each 
bar, and the width of the bar is set equal to the spacing between points. The appearance of bar charts 
(filled or hollow) may be controlled using the Filled Bars command.

____________________________
See also:

Text Menu
Units









Units command (Options > Linear/Log Scaling menu)

The Units menu command allows you to change the default appearance of tripartite grids, grain size 
distribution plots, and polar plots. NOTE:    Changing units does NOT alter the input data in any way. 
Specifying alternate units informs DPLOT how the input is related to certain aspects of the plot. It is up to 
you to perform any necessary conversions of the input data so that it matches the specified units. See 
Edit menu.

Tripartite grids
By default, a tripartite grid is set up for a shock spectra plot with frequency (X) in hertz, velocity (Y) in 
inches/sec, displacement in inches, and acceleration in g's. This menu option allows you to select from 
other built-in relationships, or enter conversion factors for your own tripartite grids.

For shock spectra plots, acceleration and displacement values are given by:

In the more general case,

If you select "user-defined" tripartite units, you must enter positive values for the constants A & B. The 
following table is presented to provide examples of proper values for A and B:

X Y 45 deg. 135 deg. A B
Hertz inches/sec inches in/sec^2 0.1591549 6.2831853
Hertz inches/sec inches g's 0.1591549 1.6273972E-02
Hertz feet/sec feet g's 0.1591549 1.9528766E-01
Hertz mm/sec millimeters g's 0.1591549 6.4070659E-04
Hertz cm/sec centimeters g's 0.1591549 6.4070659E-03
Hertz meters/sec meters g's 0.1591549 6.4070659E-01

Grain size distributions
By default, grain size distribution plots expect grain sizes in millimeters. This menu option allows you to 
select from other built-in relationships, or enter a conversion factor for user-defined units. If you select 
"user-defined" units, you must enter a positive value for the conversion factor. The grain size units are 
used to map U.S. Standard Sieve Openings and/or U.S. Standard Sieve Numbers to the X axis.

Polar coordinates
By default, angles are assumed to be in radians. This menu option allows you to select from either 
radians or degrees. Regardless of which option is selected, values of the angles will be presented in 
degrees.



    Filled Bars command (Options > Linear/Log Scaling menu) 
The Filled Bars menu command toggles the appearance of bar charts between filled and hollow bars. By 
default, a bar chart is drawn with hollow bars using the color associated with a given curve. If the Filled 
Bars option is selected, the bars are filled using the curve's associated color and a black border.



Grid lines or box (Options menu)

Controls the appearance of the X and Y axes.

Axes Only    
A single line for each of the X and Y axes, with tick marks at appropriate intervals.

Grid Lines    
Draw a box around the plot, with horizontal and vertical grid lines. DPLOT will use gray (r,g,b = 
192,192,192) lines for the grid on a color device, unless the nearest color that the output device 
can produce is equal to the background color. In that case, the grid lines will be black. For black &
white devices, the grid lines will be black. The width of the grid lines may be controlled with the 
Symbol/Line Styles command.

Box Around Curves    
Draw a box around the plot, with tick mark intervals at the appropriate intervals.

Dense Grid Lines
If this option is checked, grid lines are drawn with a single pixel or single printer dot width at a 
smaller interval than normal. These grid lines will always be drawn with this pen width, regardless 
of the pen width specified by the Symbol/Line Styles command. The Grid Lines option must be 
checked for this menu command to have an effect. Use of this option with logarithmic scales may 
result in the entire background of a plot being painted gray on the display. 

Some scaling options take precedence over the grid type selection. See Linear/Log scaling



Symbol/Line Styles command (Options menu)

You may select from six line patterns and/or twelve symbol styles. Symbols are drawn at every data point.

If any line width is set to 0.0 inches, DPLOT uses one unit (one printer dot or one pixel) for that line width. 
For output to plotters, DPLOT uses a single pen width regardless of the width you specify.

If the symbol size is set to 0.0 inches, DPLOT uses a default symbol height of 1/40 of the height of the 
output device. To draw solid symbols filled with the color associated with a curve, select the Fill symbol 
with curve color checkbox.

You can quickly set the line width and symbol size for ALL curves to the same values by selecting the 
Apply sizes to all curves checkbox.

Shortcut:
Click        on the toolbar.



Automatic plot scaling (Options menu)

Using this option, DPLOT selects the coordinates for the plot window so that the entire plot will fit within 
the window (before any zoom operation is performed).

You do not need to know anything about the data to be plotted when using this option. For this reason this
is the default scaling option when DPLOT is started up.



Manual Scaling command (Options menu)

Allows you to select the coordinates of the plot window corners. This might be useful if you are making 
plots of multiple data sets and want the extents of each plot to be identical. Use of this option may result 
in portions of the plot being clipped.

The actual coordinates of the corners may not turn out to be exactly the same as those you have 
specified. However, the corner coordinates will be the same from one plot to the next.

The number of tick mark intervals specified using the Set Physical Size command takes priority over the 
manually entered coordinates.

This command is disabled for polar coordinates.



    Set Physical Size command (Options menu)
Allows you to control the physical size of the plot window and the physical spacing between tick marks.

For example, if you specify a size of 4"w x 3"h and 8 tick intervals on the X axis, 6 intervals on the Y axis, 
then the interval between tick marks in both the X and Y directions will be 0.5" on a printer. On a display 
monitor, the size of the plot is mapped to "logical inches". (Since displays are typically viewed from a 
greater distance than printed material, Windows scales font sizes so that characters with the same height 
appear roughly the same size whether viewed on a display monitor or a printout.)    The result of this 
mapping is to provide a plot whose dimensions and font sizes appear to be the same size, whether 
viewed on the display or a printed copy.

If the specified size exceeds the capabilities of the output device (subtracting the margins set with the 
Page Setup command), DPLOT adjusts the size to one that will fit, maintaining the aspect ratio between 
the width and height.

WYSIWYG
"What you see is what you get". If the specified size exceeds the limits of the display, and WYSIWYG is 
checked, then font sizes will be adjusted along with the size of the plot. This feature causes output to the 
display to have the same appearance on a display as on printed output. Output may not be identical since
specific font sizes may not be available for one or the other device.

This option may result in less than peak performance on a display monitor, since DPLOT must iterate to 
find the combination of font sizes and actual plot dimensions that will use as much of the display as 
possible without clipping any portion of the plot. For best results, use TrueType fonts and maximize the 
window.

Number of tick marks
Although the size of the plot may be controlled, use of this option has no effect on the number of tick mark
intervals for logarithmic or probability scales.

For polar coordinates, the number of tick intervals in the Y direction is used as the number of radial tick 
marks, and the number of tick intervals in the X direction is the number of angular divisions. You can force
polar plots to be circular by specifying identical measurements for the width and height.

Zoom
The zoom feature may not work particularly well with this scaling option, since you force the number of 
tick mark intervals.

____________________________
See also:

Fonts
Page Setup



    Square log cycles (Options menu)
This option forces the physical distance between log cycles to be the same on the X and Y axes. It has no
meaning for scaling options other than Logarithmic X-Logarithmic Y or Tripartite grids. Set Physical Size 
takes precedence over this option.



Multiple Axes command (Options menu)

Displays a dialog box that allows you to specify the appearance of the coordinate axes.

Single X axis
The default condition, and the only valid option for anything other than linear or logarithmic X scales.

X2 = A+B*X1
A second X axis is linked to the primary X axis by the function X2 = A + B*X1. This option might be 
useful for displaying output in two different units, for example.

Single Y axis
The default condition, and the only valid option for anything other than linear or logarithmic Y scales.

Y2 = C+D*Y1
A second Y axis is linked to the primary Y axis by the function Y2 = C + D*Y1. This option might be 
useful for displaying output in two different units, for example. Note that the function relating Y2 to Y1 
is a relationship between the numbers, not the units, displayed alongside the axes. For example, if 
the primary Y axis has units of inches, and the second Y axis has units of centimeters, then C=0, 
D=2.54 (not 1 cm = 0. +    0.3937 inches).

Independent Y2
A second Y axis is independent of the primary Y axis. In this case, you specify which curves are 
associated with which axis. The first curve in the plot must always be associated with the primary Y 
axis. This option might be useful for plotting, for example, pressure-time histories, with pressure 
associated with the primary Y axis and impulse associated with the second Y axis.

Some scaling commands will have no effect on the appearance of data associated with the second Y 
axis. Manual Scale and other commands related to the appearance of the plot effect only data 
associated with the primary Y axis.



Number Format command (Options menu)

Displays a dialog box that allows you to specify the appearance of numbers on the axes of the plot.

The following table shows some examples using the available number formats.

With this format This number Is displayed as
Default -1.5 -1.5

0. 0.
1.5 1.5

Scientific -1.5 -1.5E+0
0. 0.E+0

1.5 1.5E+0
Fractions -1.5 -1 1/2

0. 0
1.5 1 1/2

Dollars and Cents -1.5 ($1.50)
0. $0.00

1.5 $1.50
Dollars -1.5 ($2)

0. $0
1.5 $2

Time 1 01:00:00 AM
1.5 01:30:00 AM
13 01:00:00 PM

or
13:00:00

Calendar date 1 1/1/1900
35242 6/26/1996

Fractions
Fractions are displayed to the nearest 1/64th. Fractions smaller than 1/128 are truncated.

Time
Amplitudes must be greater than 0 and less than or equal to 24. Amplitudes outside this range are 
displayed using the default format. The format used to display times can be changed with Control Panels 
International (Windows 3.x) or Regional Settings (Windows 95) applets.

Calendar date
DPLOT converts the input Excel serial number (see below) to a calendar date. By default, DPLOT uses 
the Short Date format specified in Control Panels International (or Regional Settings) applet for formatting
the date. You can control how the date is formatted by entering a format string in the Date Format box. 
Use the letters in the following table to change the date style, and then click Test. The new date style 
appears beside the Test button.

To display Use
Numbers with no leading zeros for 
single-digit days, years, or months.

Lowercase d or y, or uppercase M

Numbers with leading zeros for 
single-digit days, years, or months.

Lowercase dd or yy, or uppercase MM

Three-letter abbreviations for the 
day of the week or month.

Lowercase ddd or uppercase MMM



The full name of the day of the 
week, year, or month

Lowercase dddd or yyyy, or uppercase 
MMMM

Excel serial number
DPLOT assumes the amplitudes for a calendar scale are Microsoft Excel for Windows 1900 Date System 
serial numbers. In this system, serial numbers range from 1 to 65,380, corresponding to the dates 
January 1, 1900, through December 31, 2078. The following code converts a month, day, and year to the 
Excel 1900 Date System serial number.

if( Year .lt. 1900 .or. Year .gt. 2078 ) then
   SerNum = -1
else
  if( Month .gt. 2 ) then
     SerNum=int(365.25*Year)+int(30.6001*(Month+1))+Day-694037
  else
     SerNum=int(365.25*(Year-1))+int(30.6001*(Month+13))+Day-694037
  endif
endif



    Colors command (Options menu)
Allows you to specify the colors that will be used for plotting individual records. Two different color 
palettes are maintained ... one for a display monitor and one for a printer. Each of these palettes may 
contain up to 16 color specifications. If there are more than 16 curves, the color table is recycled (curve 
#17 uses color #1, curve #18 uses color #2, etc.)    Color palette entrys are saved to DPLOT's initialization
file and are restored in subsequent runs.

Display
Presents the Select Display Colors dialog box which may be used to alter the color palette for the 
display.

Shortcut:
Click        on the toolbar.

Printer: Edit
Presents the Select Printer Colors dialog box which may be used to alter the color palette for the printer.

Printer: Black & White
Sets all color palette entries for the printer to black.

Printer: Gray Scale
Creates a gray scale palette for the printer, with values ranging from 0 (black) to 195 (out of 256) for 
palette entry 16.

Printer: Copy Display
Copies the current display palette to the printer palette. Subsequent changes to the display palette will 
not cause corresponding changes to the printer palette.

Restore Defaults
Destroys your color selections for both the display and printer and restores the default color specifications
built into DPLOT. The default colors are:

Display Printer
Index R G B R G B

 1 255 0 0 0 0 0
 2 255 0 85 13 13 13
 3 255 0 170 26 26 26
 4 255 0 255 39 39 39
 5 170 0 255 52 52 52
 6 85 0 255 65 65 65
 7 0 0 255 78 78 78
 8 0 85 255 91 91 91
 9 0 170 255 104 104 104
10 0 255 255 117 117 117
11 0 255 85 130 130 130
12 0 255 0 143 143 143
13 170 255 0 156 156 156
14 255 255 0 169 169 169
15 255 170 0 182 182 182
16 255 85 0 195 195 195

To alter the current color specifications:



1 Select either "Display" or "Printer:Edit" from the "Colors" menu.
2 To change the red, green, and/or blue components for a curve's color, click on the appropriate curve

index in the boxes under "Curve Index:", or press the <TAB> key until the appropriate box is 
highlighted, then press <Space>.

3 Change the color for the selected curve index by doing one of:
· Enter values ranging from 0 to 255 inclusive in the red, green, and/or blue edit boxes.
· Enter values ranging from 0 to 240 in the hue, saturation, and/or luminosity edit boxes.
· Drag the cursor in the color refiner box to select a color. Drag the cursor in the luminosity bar 

to change the brightness of the color.
A dithered version of the selected color will be displayed in the Color/Solid box, as well as the box 
for the currently selected curve. The nearest system palette color will be displayed in the right side 
of the Color/Solid box.

4 Repeat steps 2 - 3 for all palette entrys you wish to change.
5 Click on "OK", or press "Enter".

Not all devices are capable of displaying the exact colors that are selected. With a 16 color display driver, 
for example, Windows selects the system palette color that is closest to the selected color. You can force 
the selected colors to match the system palette by pressing ALT+O or by double-clicking on the right side 
of the Color/Solid box for each curve.



    Fill Between Curves command (Options menu)
This command allows you to draw a hatch pattern or solid fill between two curves.

Select the curves to fill between in the 1st Curve and 2nd Curve list boxes. If None is selected for either 
curve, or if the 1st and 2nd curves are the same, the fill operation is not performed.

The color of the fill may be controlled with the Red, Green, and Blue text boxes. Enter a number from 0 to 
255 in each of these boxes, or click on the adjacent spin buttons to change these entries. R,G,B = 0,0,0 
corresponds to black; 255,255,255 is white.

If the User-defined fill pattern is selected, you may create your own hatch pattern by clicking on any of the
grid squares in the 8x8 grid pattern. Clicking on a square toggles its state to and from the background 
color and the color selected with the R,G,B controls. Unlike the built-in hatch patterns (Horizontal, Vertical,
etc.), the background for User-defined patterns is drawn on the plot and will obscure any previously 
drawn information.



Data Processing command (Options menu)

This command allows you to enter a data processing mode in which several operations are automated. 
The key features of data processing mode are geared towards producing data plots used by the WES 
Structures Laboratory and may not be appropriate for your use.

Formatting
· Square format:

Plot width and height are 5.15 inches (about 131 mm).
Both the X and Y axes have 10 grid intervals.

· Wide format:
Plot width is 6.15 inches; height is 3.69 inches.
X axis has 20 grid intervals; Y axis has 12 grid intervals.

· Scaling is linear X, linear Y.
· Pen width is 1 dot or pixel for curves, 0.02 inches for the box around the plot, and 1 dot or pixel for the

grid lines.
· All labels use the Arial TrueType font. Normal text is 10pt; the first title line is 18pt; all other text is 

14pt.

Units
Input units should correspond to the following table. If the input units do not match the values specified, 
you should not select "Use DPLOT-generated axis labels".

Data type Input X Input Y Output X Output Y
Unknown don't care don't care same same
Pressure Time, msec Pressure, psi Time, msec Pressure, psi

Impulse, psi-sec
Stress Time, msec Stress, psi Time, msec Stress, psi

Impulse, psi-sec
Acceleration Time, msec Acceleration, g's Time, msec Acceleration, g's

Velocity, feet/sec
Displacement, 
inches

Deflection Time, msec Deflection, inches Time, msec Deflection, inches
Strain Time, msec Strain Time, msec Strain
Temperature Time, msec Temp., deg. F Time, msec Temperature, deg. F

Y axis labels will be the same color as the corresponding curve, regardless of the color chosen with the 
Fonts command.

Menu Commands
Several menu commands are disabled when in data processing mode:
· Erase a curve.
· Swap X,Y.
· Linear/Log scaling.
· Multiple axes.
· Compare curves.
· Curve fit.
· Integrate a curve.
· Lump two curves.

In addition, the decimation commands do not generate a new curve ... they replace the curve that is 
operated on.



Integrations
For records consisting of pressure or stress values, DPLOT automatically generates an impulse record. 
For acceleration records, DPLOT automatically generates velocity and displacement records.

Editing the primary record in any way (pressure, stress, or acceleration) results in automatic re-generation
of the integrated records. Please note:    The initial amplitude of an integrated record will always be zero. 
Some operations on the primary record may have an undesirable or unexpected effect on integrated 
records. For example, truncating a pressure record (deleting data before a specified time), may result in 
shifting the impulse. To view or print a range in time without changing the integrated amplitudes, zoom in 
to the desired limits or use the Manual     Scale   command rather than truncating the primary record. 

Generated records (impulse, velocity, or displacement) can not be edited directly. Any changes must be 
made to the primary record.

Acceleration plots
Acceleration is plotted on a separate plot from velocity and displacement. To switch views from 
acceleration to velocity, select the Velocity/Displacement command on the View menu (or press 
Shift+TAB). Switching to the velocity plot changes this menu command to "Acceleration".

To save a single curve, the curve must be visible. For example, to save either the velocity or displacement
records using the Save As command, switch views if necessary so that the velocity plot is visible.

Array sizes
Since data processing mode relies on DPLOT being able to make very specific assumptions about the 
content of the curves, you cannot change the maximum number of curves while in data processing mode.
Doing so turns data processing mode off.



    Text Menu

Title/Axes
Enter or edit title strings and axis labels.

Legend/Labels
Enter or edit curve legend, labels, or legend title.

Label Points
Add, edit, move, or delete labels for specific data points.

Date
Toggle display of the date. The date will be displayed using the Short Date format selected with the 
Control Panel International application.

Print Caption
Toggle display of the document caption in the lower right corner of the plot. The caption is normally 
either the filename of the document or the source of the data; e.g. EXCELData.

Add/Edit Note
Enter or edit a notation placed at an arbitrary location on the plot.

Fonts
Change the typeface and/or other attributes for various labels.



    Title/Axis Labels

You have clicked on one of the title lines or axis labels.

You may edit these labels in one of two ways:
· Using the Title/Axes menu command.

· Pointing to the label with the mouse and double clicking the left mouse button.

Each of these strings is limited to 80 characters. The appearance of these strings may be changed with 
the Fonts menu command.

The third title line may not be edited while in data processing mode, since    this string is continuously 
updated by DPLOT as you edit the data. If you have selected the DPLOT-generated labels option in data
processing mode then you are also prevented from editing the X and Y axis labels.

____________________________
See also:

Data Processing



    Legend

You have clicked on the legend.

You may edit the text of the legend in one of two ways:
· Using the Legend/Labels menu command.
· Double clicking the left mouse button while the mouse pointer points to any part of the legend.

The legend may be moved by clicking the left mouse button while the mouse pointer points to any part of 
the legend, and dragging the legend to a new location.

The font used in the legend may be changed with the Fonts menu command.

Other features of the legend may be edited with the Legend/Labels menu command.



    Legend/Labels command (Text menu)

Enter or edit curve legend, labels, or legend title.

Maximum number of characters
Character strings for the legend are limited to 40 characters. Curve labels are limited to 5 characters, and 
are placed beside the last data point that is located within the plot window.

Legend title
The legend title will be placed above the legend for each of the individual curves. If no legend is specified 
for any curve, the legend title may still be used to draw a note on the plot.

Legend line length
Length of the line segment appearing to the left of each legend string. The line is drawn with the same 
attributes (color, style, and pen width) as the associated curve.

Maximum number of rows
Refers to the maximum number of legend strings that will be placed in a single column. Additional 
columns will be used if the number of legends exceeds this number.

Frame legend
Check this box to draw a rectangle around the legend.

Opaque
Check this box to hide items that intersect the rectangle bounding the legend.

Shortcut:
Double click on the legend.

Note:
To move the legend, point to the legend and drag to the desired location.



    Label Points command (Text menu)

Adds a label to a specific data point. A plot may have up to 20 point labels.

To embed the amplitude of a data point in a label, type $Y in the Label field. To embed the abscissa of a 
data point in a label, type $X. When the label is drawn the corresponding numeric values will be 
substituted for these control codes.

To use only the amplitude of the data point as the label, check the "Use Amplitude Only" box.

To move a label, select the "Move Label" menu command, or point to the label and drag to the desired 
location.

To edit a label, select the "Edit Label" menu command, or point to the label and double click the left 
mouse button.



    Fonts command (Text menu)

Allows you to change the typeface, color, size, and other attributes of the fonts used to display various 
labels.

Shortcut:
Click        on the toolbar.

Character size
DPLOT uses the user-specified character size when: 1) the output device is not a display monitor, or 2) 
DPLOT's window has been maximized. For non-maximized windows, DPLOT proportions the size of 
characters so that a plot will have the same general appearance as a maximized window. If the 
WYSIWYG option of the Set     Physical     Size   command is in effect, then fonts are scaled down, if necessary,
so that a plot on the display will have the same appearance as a printed copy. 

Typeface
By default, DPLOT uses a TrueType Arial font for all text.

Be sure that you have enabled TrueType fonts using the Fonts option of ControlPanel before running 
DPLOT. TrueType fonts will generally provide the best performance across multiple output devices, and 
are the only standard fonts that can be rotated reliably.
 
If printing to a pen plotter, DPLOT selects the plotter's stick font, regardless of which typeface you have 
chosen.

Saving font options
On exit from DPLOT, font information is stored in the initialization file DPLOTW.INI, found in the Windows 
directory. If DPLOTW.INI is erased or otherwise damaged, DPLOT will use the default TrueType Arial font 
until you select new fonts. Font point sizes are saved to a DPLOT data file.



    Add/Edit Note command (Text menu)

Enter or edit a notation, placed at an arbitrary location on the plot. The notation is limited to 511 
characters. Unlike most DPLOT dialogs, pressing ENTER results in a new line in the notation (normally, 
pressing ENTER is equivalent to clicking on OK). Press CTRL+TAB to embed a TAB character in the 
note. Press TAB to shift the input focus to another control.

To paste the contents of the Clipboard to the notation, move the cursor to the desired insertion point and 
press CTRL+V.

To move a notation, point to the bounding rectangle and drag to the desired location. 

The font used in the notation is identical to that used in the legend, and may be changed with the Fonts 
menu command.

Frame note
Check this box to draw a rectangle around the notation.

Opaque
Check this box to hide items that intersect the rectangle bounding the notation.

Button activated
Check this box to display a pushbutton in place of the note. Clicking on the pushbutton displays a popup 
window containing the note. If this option is selected the note will not be printed or copied to the Clipboard
by the Copy Picture command. The text appearing on the note is controlled by the Button Text edit box. If
this box is left blank the button will contain the word "Note".

Tab Stops at
Enter the number of characters for each tab stop, or click on the arrows until the desired tab spacing is 
selected. Tab characters may be embedded in the note by typing CTRL+TAB.

Shortcut:
Double click on an existing note.
or
Click        on the toolbar.



    Notation

You have clicked on the notation for the active plot.

You may edit the notation text in one of two ways:
· Using the Add/Edit Note menu command.
· Double clicking the left mouse button while the mouse pointer points to any part of the notation.

The notation may be moved by clicking the left mouse button while the mouse pointer points to any part of
the notation, and dragging the notation to a new location.

The font used in the notation is identical to that used in the legend, and may be changed with the Fonts 
menu command.



    Client Area

No help here!    Make something up!



    Maximize Icon

Click on the maximize icon to enlarge the active window to fill the available space. The application 
window expands to fill the entire screen. A document window expands to fill the DPLOT window.



    Restore Icon

Click on this icon to return the active window to its size and position before you chose the Maximize or 
Minimize command.



    Minimize Icon

Click on the minimize icon to reduce the application window to an icon.



    Sizing Border

You can change the size of the application or document window by dragging one or more borders to the 
position you want.

1 Point to the border or corner of the window you want to move.

2 When the mouse pointer appears as a , drag the window border or corner until the window is the 
size you want.

Tip
· To view Help as you work in an application, you can arrange the Help window and the application 

window so they appear side by side.



    Control Menu

This topic describes the control menu.



    Title Bar

Located along the top of a window and contains the name of the application and document.

To move the window, drag the title bar.

Note: You can also move dialog boxes by dragging their title bars.



    Scroll bars

Displayed at the right and bottom edges of the DPLOT window. The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in DPLOT's output. You can use the mouse to scroll to other 
parts of DPLOT's output.

Vertical scroll bar
Item Mouse action

Click to scroll up one line.

Click to scroll up one full window.

Drag to move to an approximate location in the document.

Click to scroll down one full window.

Click to scroll down one line.

Horizontal scroll bar
Use the horizontal scroll bar to move left and right, just as you use the vertical scroll bar to move up and 
down.



    Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.

Clicking  in the upper-right corner of a maximized window is the same as choosing the Restore 
command.

Shortcuts

Double-click the title bar.



    Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note: This command is unavailable if you maximize the window.



     Size command (Control menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

Note: This command is unavailable if you maximize the window.



    Minimize command (Control menu)

Use this command to reduce the application window to an icon.

Clicking  in the upper-right corner of the window is the same as choosing the Minimize command.



    Maximize command (Control menu)

Use this command to enlarge the active window to fill the available space. The application window 
expands to fill the entire screen. A document window expands to fill the application window.

Clicking  in the upper-right corner of the window is the same as choosing the Maximize command.

Shortcuts

Double-click the title bar



    Next command (document Control menu)

Use this command to switch to the next open document window. DPLOT determines which window by the
order in which you opened the windows.

Shortcuts

CTRL+F6



    Close command (Control menu)

Use this command to close the active window. 

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts

ALT+F4 closes the application window.

CTRL+F4 closes the document window.



    Switch To command (Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or close an 
application on the list.

Shortcut

CTRL+ESC

Dialog Box Options
Task List

Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar. Note: This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. Note: This option does not affect    
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



drag

To hold down the mouse button while moving the mouse.



dialog box

A box that displays the available command options for you to review or change.



click

To press and release a mouse button in one nonstop motion.



Clipboard

The Clipboard is a temporary storage area for text and graphics that you are copying or moving from one 
location to another. The Clipboard is a common holding area among Windows applications.

To display the contents of the Clipboard
In the Program Manager Main window, double-click the Clipboard Viewer icon, or the ClipBook Viewer 
icon in Windows for Workgroups.

Clipboard Viewer icon

ClipBook Viewer icon

To close the Clipboard Viewer, choose Exit from the File menu.



DDE

Dynamic Data Exchange is a mechanism for interprocess communication. DDE is based on the 
messaging system built into Windows. Two Windows programs carry on a DDE "conversation" by posting 
messages to each other. These two programs are known as the "client" and the "server." A DDE server is 
the program that has access to data or features that may be useful to other Windows programs. A DDE 
client is the program that obtains this data from the server.

DPLOT can act as both a DDE client and a server.



double-click

To rapidly press and release a mouse button without moving the mouse. Double-clicking carries out an 
action, such as starting an application.



spin button

A spin button is a control you can use with another control to increment and decrement numbers. You can
also use it to scroll back and forth through a range of values or a list of items.



    How do I ...?

Answers to common questions about DPLOT for Windows.

Data Entry
How do I create a plot from scratch?    

How do I import data from another Windows application?    

How do I import data from a DOS application?    

Printing
How do I print colors and/or gray shades on a B&W printer?    

How do I print several documents unattended?    

How do I print multiple documents on the same page?    

Scaling
How do I specify a tick mark interval?    

Miscellaneous
How do I get DPLOT to speak to me?    

How do I abort a document repaint in progress?    



Windows simulates colors and gray shades on a B&W printer using patterns of black dots. For this 
feature to work as expected, the width used for a given line or curve must be greater than 1 printer 
dot. When first installed, DPLOT draws lines with a width of 1 pixel on display monitors and 1 dot on 
printers. For best results when printing colors or gray shades, the minimum line width used for 
drawing curves should be about 12 dots, or 0.02 inches on a 600 dpi printer or 0.04 inches on a 300 
dpi printer. Line widths used for each curve may be changed with the Symbol/Line Styles command 
on the Options menu, or by selecting the Symbol/Line Styles tool.

    Symbol/Line Styles tool.



Use the Macro command on the File menu to create a macro for printing a series of files unattended. 
After creating and saving the macro, select the Run button from the Macro dialog box to process the 
commands. For example, the following macro commands will cause DPLOT to print all DPLOT files in
the directory C:\MYDATA:
Directory("C:\MYDATA")
FileType(1)
ForFilesIn("*.GRF")

FilePrint()
NextFile
NOTE: DPLOT uses the default printer settings (set with Control Panel) to run macro commands. 
Changes made to the printer settings within DPLOT will have no effect on the printer settings used by
macros.



1) Open or create all documents that you want to print on the same page.

2) Select the document to be printed in the upper left corner of the page (click anywhere within the 
document, or select it from the Window menu)

3) Select the Print command from the File menu.

4) Click the "Multiple" button in the Print dialog box, or press ALT+M.

5) Select the layout for the page: Vertical, Horizontal, or Two Columns.

6) The active document (selected in step 2) is shown selected and grayed, indicating that it must be 
printed. Placement of other documents on the page is controlled by the order in which the 
documents are selected. Select other documents by clicking on the corresponding checkbox, or 
by pressing the corresponding numeric key.

7) Enter the desired spacing between plots in the "Space between" box.

8) Click the "OK" button, or press ENTER.

9) Modify the printer settings if necessary, then click the "OK" button or press ENTER.



To set a specific tick mark interval:

1) Using the Set Physical Size command on the Options menu, enter the number of desired tick 
mark intervals on the X and Y axes.

2) Using the Manual Scale command on the Options menu, enter the extents for the X and Y axes 
such that the range in magnitudes divided by the number of intervals is equal to the desired tick 
mark interval.

The resulting tick mark interval may not be exactly as described above. DPLOT will adjust the extents
set with the Manual Scale command such that the tick mark interval is some multiple of 1.0, 1.5, 2.0, 
2.5, 3.0, 4.0, 5.0, 6.0, or 8.0 times a power of 10.

For example, if 6 tick mark intervals are specified on an axis using the Set Physical Size command 
and the extents set with the Manual Scale command are 0.0 to 10.0, DPLOT adjusts the upper extent 
to 12.0 so that the tick mark interval is 2.0 rather than 1.6667.



DPLOT will echo messages to a sound card if your system is equipped with Monologue for Windows™. 
Monologue for Windows is bundled with the SoundBlaster™ and other popular sound cards. To take 
advantage of this feature, start Monologue for Windows and insure that the mode is set to DDE Server.



By default, DPLOT automatically redraws a plot any time you edit any portion of the plot that results in a 
change in appearance. This feature may become tedious when working with large data sets. To cancel a 
redraw in progress, press <Escape>. You may subsequently force a redraw by selecting the Redraw 
menu command or pressing F9.



1) Open a new document window if necessary by selecting the New command on the File menu, or 
by pressing CTRL+N.

2) The current maximum number of curves and maximum number of data points per curve is shown 
on the right side of the status bar at the lower edge of the DPLOT window. If either of these 
values is insufficient for the new document, enter new values by selecting the Resize Arrays 
command on the File Menu or by double-clicking the "Max Size:" area of the status bar.

3) Select the Edit Data command on the Edit menu and enter the X,Y data pairs for the first curve. 
Repeat this step for all curves.



Three methods are available for importing data from other Windows applications.

The Paste command (Edit menu)
The Paste command is the method most likely to be supported by another Windows application. 
Once data is pasted from another application, DPLOT owns the data. Changes to the data in the 
source application are not reflected in the DPLOT document.

The Paste Link command (Edit menu)
The Paste Link command establishes a link with the source of the data. Changes to the data 
made in the source application are reflected in the linked document. Unlike the Insert Link 
command, this method requires switching to the source application and back to DPLOT.

The Insert Link command (Edit menu)
The Insert Link command performs roughly the same function as the Paste Link command, 
except that it does not require switching to the source application to initiate the action.



1) Click the application's Control-menu box or press ALT+SPACEBAR to open the Control menu.

2) From the Control menu, choose Edit.

3) From the Edit cascading menu, choose Mark.

4) Select the information you want to copy.

5) Click the application's Control-menu box or press ALT+SPACEBAR to open the Control menu.

6) From the Control menu, choose Edit.

7) From the Edit cascading menu, choose Copy.

8) Switch to DPLOT.

9) Choose the Paste command from the Edit menu, or press CTRL+V.

____________________________
See also

Paste command




